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Introduction to the Principal Toolbox
Principal Toolbox offers a powerful set of tools for the management of your projects, folders and
portfolios. PRINCE2™ support for projects is offered in project models and in the way processes are
supported by the Principal Toolbox by default. Customising the Principal Toolbox to follow the processes
of your own organisation is easily accomplished.
This manual offers a comprehensive guide explaining how to use the Principal Toolbox. In the
application itself the help is available in the right top location. You can access the help by
clicking the 'Help' link located in the right-hand top of the main page. This will open the help
pages available online (not integrated within the Principal Toolbox).
The complete manual is available in PDF format for download as well: Download User Manual as a PDF
file
Note: This manual is to support release 8.0. Where applicable, notes about the required version
is stated.
Older versions of the manual (English) can be found below:
Version

1.1

Link

5.5

Manual

6.0

Manual

6.5

Manual

7.0

Manual

7.5

Manual

Structure of Principal Toolbox
As of release 8.0 organisational units have been introduced. To read about organisational units in detail
click here 14 .
The introduction of organisational units has restructured the Principal Toolbox.
The functionality within the Principal Toolbox can be organised in a hierarchical structure. This allows to
enable functionality at the appropriate level.
Organisational units enables to group data according to the organisational view (countries, business
units, teams, products, etc.).
For every organisational unit the time entry and the resource allocation may be combined into resource
management.
It also enables local portfolio and programme/project management and additional reporting levels.
The picture below shows an example of what the hierarchy can be within the Principal Toolbox.
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Example of an enterprise hierarchy. Each OU will have its own span of control for managing portfolio's, programmes and
projects.

This structure can be changed to fit your organisation's needs. The highest level is generally referred to
as the 'enterprise level'. Within every individual organisational unit, folders can be added to organise
programmes and projects.
The folders can be any of the following types:
· Sub folders, programmes and projects:
· Sub folders and programmes:
· Projects:

can contain sub folders, programmes and projects
can contain sub folders and programmes
can only contain projects

By choosing the right type of folders, the actual structure of for example programmes and projects within
your organisation can be reflected in the Principal Toolbox. The enterprise hierarchy aids in keeping an
overview of all programmes and projects run throughout the organisational unit(s).
The same projects that have been fit in with this hierarchy (reflecting the organisational structure), can
also be made part of a portfolio. Portfolios are managed in a separate area within the Principal Toolbox,
and this functionality is provided by an add-on module (Portfolio Management add-on 40 ).
The illustration below shows how Project Management and Portfolio Management work together:

Principal Toolbox 8.0
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Hardware and Software requirements
The following hardware and software requirements for client computers must be in place for using
Principal Toolbox.
Requirements f or general use:
Memory

1 GB or more

Browser

Microsof t Internet Explorer 9 or later, FireFox or Google Chrome1, 2

Display

Resolution 1024x768 or higher

Requirements f or using reports and exports:
Sof tware

Microsof t Of f ice 2007 or later

Sof tware

Adobe Acrobat Reader

3

If you experience problems while accessing the Principal Toolbox, please verify security settings
your browser.

9

of

1. Be sure there are no script blocking security settings or script blocking firewalls active.
2. Other browsers are supported based on best effort, issues may exist.
3. For working with automated reports in Excel, the template needs permission to execute macro's. Excel 2003 is only supported using the old
reporting template. Reports based on the new report template (as of release 6.5) require Excel 2007 or later. This new report template supports
Office for Mac as well.

1.3

Required Internet Explorer Security settings
The Principal Toolbox is completely web-based. This means it runs in your internet browser. Below you
will find a table with the required security settings of the appropriate Internet Explorer security zone used
by the Principal Toolbox. In Internet Explorer go to Tools > Internet Options, select the Security tab and
choose custom level to change the settings.
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Sectio Setting
n

Value

Rem arks

Enable

Script errors on dif f erent pages occurs when
disabled.

Automatic prompting f or f ile downloads

Enable

Functions like pack project of f line can't of f er to
download the of f line project.

File download

Enable

When disabled, automated reports and documents
can't be downloaded.

Disabled

Internet Explorer blocks the "Edit name f or new item"
dialog af ter adding the f irst product on the Edit

Activ eX controls and plug-ins
Initialize and script Activ eX controls not marked as
saf e f or scripting
Downloads

Miscellaneous
Use Pop-up Blocker

project plan page when enabled. On maximum
security this includes all pop-up windows, ev en
those that prov ide necessary f unctionality such as
the calendar pop-up f or choosing a date, the help
window, and more.
Allow META REFRESH

Enable

Internet Explorer window stay s blank af ter login
when disabled

Allow websites to open windows without address or
status bars

Enable

Internet Explorer will display a grey address bar in all
pop-ups when disabled

Submit non-encry pted f orm data

Enable

When disabled, Internet Explorer can't update
changes in text f ields.

Activ e scripting

Enable

Login button on login screen does not react. Drag
and drop in Edit Project Plan window won't work when
disabled

Automatic f or logon
only in Intranet zone

When Single Sign On is enabled, this setting allows
to sent username and password ov er the intranet

Scripting

User Authentication
Logon

Other problems might be related to the use of virus scanners, firewalls or browser add-ons, like the
Google toolbar which also has pop-up or script blocking. Consult your software documentation on those
products for details on how to configure them to allow pop-up windows and scripts from the Principal
Toolbox.

1.4

Logging on
Before you can log on to the Principal Toolbox, the system administrator must first create a user name
for you. After this has been done, you can log on using the following steps.
Note: Some organisations have so-called single sign-on configuration. In this case, you are
logged on automatically with your organisational account.
1. Start up Internet explorer and navigate to the Principal Toolbox homepage. The internet address is
found in the email that you have received from your administrator. The user name and password are
also found in this email.
2. The log on window is shown.
3. Fill in your user name and password and click OK. The Principal Toolbox will open with your
homepage.
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Navigation
The Principal Toolbox is a web-based application in which navigation works the same way you are used
to on the internet. You perform actions by clicking with your mouse button or by clicking hyperlinks on
the page.
Note: As of release 6.5+ the browsers 'Back' button may be used as well.
Navigation with organisational units:
Navigating through the Principal Toolbox is done by using the dark blue header within your browser
window. 'Enterprise' is the highest level in the hierarchy for your organisational units. From there you
can navigate down the branches of the organisation tree (through the drop down menu) to locate your
folders (containing sub folders, folders and projects) on the appropriate 'Project Management' tab. On
this tab select the appropriate folder to navigate through folders and projects within.

Project Dashboard; bread crumbs (Navigation with organisational units).

Note: Classic navigation is available after migration.
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Classic Navigation:
Classic navigation through the Principal Toolbox is done by using the dark blue header within your
browser window. 'Enterprise' is the highest level in the hierarchy for your organisation's organisational
units, folders and project tree. From there, you can navigate down the branches of the tree (through the
drop down menu) to locate your projects.
On your home page, accessible through the 'Home' link in the dark blue header, you will find all
projects, products and log items you are connected to. This way, you can quickly locate your projects
and items you have to work on.
Throughout the application, except on your homepage, you will find the so-called bread crumbs that
show you where you are in the organisational unit, folder and project tree. Click the bread crumbs
anywhere higher up in the hierarchy to navigate to that location.

Project Dashboard; bread crumbs (Classic Navigation).

2

Basics Principal Toolbox

2.1

Home page
On the home page you are able to see all folders and projects you have a role/part in, as well as
products, log items (including issues, risks, etc.) that have been assigned to you. After logging on to the
Principal Toolbox you will be directed to your home page.

Principal Toolbox 8.0
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Home page

1.
2.
3.
4.
5.

Area for general information and widgets.
Products/documents to be approved (add-on Advanced Customisation & Workflow)
Time sheets to be filled in and/or approved (add-on Time sheets)
All portfolio's (add-on), folders and projects you have a role in.
All products, issues, risks, quality reviews, actions and changes assigned to you.

Configuring your home page
To configure the layout of your personal home page, click the button Customise Home Page. The
opened window gives you the possibility to select:
· Which portfolios (add-on) should be displayed.
· Which folders should be displayed.
· Which projects should be displayed.
· How to display the products.
· How to display the log items.

13
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Editing Home page settings

Tabs shown on your home page
Your home page displays several tabs. Depending on your organisation's license some tabs might not be
available. Here you can see:
· Approve Hours shows all hours from other users you should approve or disapprove.
· My Time Sheets shows all your time sheets when time registration is turned on.

2.2

Organisational Units
Note: As of release 8.0 of the Principal Toolbox there is the possibility to use Organisational units (OU).
To edit the organisational units, navigate to your company by clicking on the header in the drop down
menu.

Click on your companies name to edit the organisational units.

Principal Toolbox 8.0
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You will now see an overview of all the organisational units.
By clicking on the
By clicking on the

button you can add an organisational unit.
button you can archive outdated organisational units.

You can start editing an organisational unit by clicking on it in the overview.

Overview of the organisational units

When editing the highest level of organisational units the lower level organisational units will appear.
This overview shows the location of all your organisational units and has space for editable widgets.
To choose the widgets that suit you best see the widgets 188 section of the manual.
Editing and archiving organisational units on this level is done identically to the higher level.

Example of an Organisational unit's dashboard on the lower level

When editing a lower level organisational unit click
organisational unit.
By clicking
edited.

to edit the name or description of the

on the 'Properties' tab, the configuration for this organisational unit can be

15
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For every organisational unit this configuration can be changed independently.

Configuration of the organisational unit

To save the changes, click

.

Permissions and roles
Configuring roles for organisational units can be done on all levels of organisational units and can be
found on the 'Properties' tab.
There are four 'regular' roles and there are 'additional' roles.
For more information on permission and roles see the permissions and roles 22 section of the manual.

Roles on organisational unit level

Reporting on organisational units
Reports on organisational units can be found in two place which generate reports with a different scope.
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· The first option is the reports tab in the organizational unit.

The reports that report on the current level and all lower levels.

The reports generated on the reports tab for the OU include information from the current OU and all
lower levels.
· The second option are the reports on local levels such as 'resource management'.

The reports that report on the current level only.

The reports generated this way will only report about the current level and functional are (e.g. portfolio

Principal Toolbox 8.0
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management).
Resource Management Configuration
To configure resource management and/or time entry in organisational units, navigate to the resource
management tab in the organisational unit.
Next click

Resource management configuration in organisational units

Select the appropriate time entry configuration and Non-project activity set to configure the resource
management.

The resources can be edited in the appropriate organisational units. Click

Edit resources in organisational units

Select the available resources and save by clicking

.

.
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Project management dashboard
The Project management dashboard is the highest level in the folder and project tree. The Project
Management dashboard is accessible through the link (drop down) in the blue header.
On the Project management dashboard you are able to reach all folders within the organisation and you
are able to get information regarding the progress of folders as judged by the folder manager.

Enterprise dashboard

1.

Tab pages
The tab pages are standardized on the enterprise dashboard. The name of the tab page indicates the
content of the page.
- Project Management
: This is the main (default) page.
- Properties
: The properties and history of the projects for this organisational unit
can be found here.
- Documents & Knowledge : A folder structure can be created here where files of any format can
be stored and shared.
- Reports
: This tab shows all reports from all underlying projects (only visible
when configured, see Principal Toolbox 216 configuration).
- Models
: An overview of the project models on the enterprise level.
- Archive
: Archived work areas / folders / project lists and project models on
the enterprise level.

2.

Area for customisation and widgets.

3.

folder listing
A list of all work areas / folders and project lists on this level. Shown behind each folder name is a
RAG indicator which indicates the status of the folder and the manager’s name.

Principal Toolbox 8.0
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Reports
This area is shown if you have either a manager role or a reader role on this level. Reports give you
access to views (tables) concerning all folders, projects, products etc. within all project within the
database.

Functions at project management level
Within the project management level, buttons are available so you can edit user roles on the Enterprise
dashboard (‘Edit members’), edit the text and the image on the dashboard (‘Edit’), add and edit widgets
('Edit Widgets'), send an e-mail, print the current page and search the entire database.

2.4

Folder dashboard
The folder dashboard provides you with an overview of all sub-folders and projects within the respective
folder.

Folder dashboard

1.

Tabs
The tabs are standard for each folder. The name of the tab indicates the content of the page.
Depending on your organisation's license some tabs might not be available.

Principal Toolbox 8.0

- Dashboard
- Properties
- Gantt & Dependencies
- Documents & Knowledge
- Models
- Archive

Basics Principal Toolbox

:
:
:
:
:
:
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The main and default page of the folder.
An overview of the folder properties and history.
Graphical representation of all projects within the folder.
Archive of important documents and/or useful best-practices.
An overview of the project models within the folder.
Archived projects and project models within the folder.

Fold

2.

Area for customisations and widgets.

3.

List of projects (and folders when applicable)
Gives an overview of the projects within this folder. A number of figures are presented that enable you
to get an overview of the project status. The traffic lights used for the planning, hours and costs are
defined by the tolerances 75 set by the folder manager.

4.

List of available project models
Gives an overview of the project models available within this folder.

5.

Logs
On folder level the following logs are available for use; issue, risk and daily/action log. A counter is
displayed for each log indicating the number of items there are for each log and if there are new
items. The log is selected by clicking the name of the log.

6.

Report
Creation of reports/views about all projects and products within this folder.

Functions at folder level
Here you can make the ‘folder dashboard’ available to users 22 (‘Edit members’), change the text and
the logo of the dashboard (‘Edit Properties’), send an e-mail, print the current page, use the search
function. The folder manager can also setup the tolerances 75 for the planning, hours and costs of all
projects with this folder by using the ‘Edit Tolerances’ button. Finally, the 'Edit Widgets' buttons allows
administrators to define the set of widgets 188 available to the folder.

2.5

Mobile Application
As of release 7.0 it is possible to use Mobile Reporting and Mobile Time Entry using the Fortes app.
They allow for managers and stakeholders to always have the appropriate reports with them and for all
employees to enter hours using only their tablet or smartphone.
Note: To start using this functionality, download the app in the appstore or google play store

Principal Toolbox 8.0
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Opening screen op the Fortes app

Principal
Enter the URL of your Principal Toolbox
Toolbox
URL:
Username: Enter your username
Password: Enter your password

Click
The application can be used for Stakeholder Reporting

2.6

56

and Time Entry

133

.

Permissions and roles
Authorisation model
The Principal Toolbox allows for two types of users:
1. Administrators, who get access to everything everywhere
2. Users, who get access to entities and areas within the Principal Toolbox by assigning them roles
The roles that are assigned to a user determine what access the user has. Access can be restricted to
various actions, like getting read-only access or allowing full access including removing items. A user
can be assigned multiple roles at the same time. Below follows an overview of the various roles and the
access rights associated with them.
Note: For folders and projects security-enabled locations that have no security set, ALL members
of the organisational unit have access. Please k eep this in mind if you do not want users to
access such locations.

Principal Toolbox 8.0
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Roles on organisational units
Role

Rights

Organisational unit Manager

· Create and archive folders in the organisational unit
· Assign folder manager(s) to a new folder within the
organisational unit
· Assign folder reader(s) to a new folder within the
organisational unit
· Manage roles at the organisational unit level
· Access information of all folders and projects within the
organisational unit
· Modify picture and text on organisational unit dashboard
· Defining resource availability
· Allocating project and non-project work
· Assigning and removing Non-project Activity Sets from the
organisational unit
· Defining resource availability
· Allocating hours against projects and non-project
activities

Organisational unit Support

· Identical access rights as the Organisational unit Manager

Organisational unit Reader

· Access information of all folders and projects within the
organisational unit
· Read access to the resource management of the
organisational unit
· This includes read access to all allocation requests, time
allocations and availability data on the applicable
organisational unit

Organisational unit Member

· Can be assigned to individual portfolios as readers or
managers within the organisational unit
Note: before being granted access to portfolios,
users first have to be a member of Portfolio
Management

Additional roles on organisational units
All roles within portfolios, folders and projects can be configured for individual organisational units.
Roles on Project Management
Role

Rights

Project Management Coordinator

·
·
·
·
·

Project Management Reader

· Read access to all data within project management

Create and archive folders
Assign managers and readers to individual folders
Manage roles at all levels within the folders
Access to all folders and their underlying data
Remove and restore archived folders

Roles on Folders
Role

Rights

Folder Manager

· Create, move and archive projects and project models on
assigned level
· Create, move and archive sub-folders
· Remove and restore archived projects, project models on
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Rights
assigned level
· Assign project manager to a new project
· Manage roles (managers and readers) of assigned level
· Create, edit and remove issues, documents, risk’s etc.
within assigned level
· Read all information within own and underlying levels
· Set tolerances for the projects within assigned folder /
project list
· Modify layout of folder / project list dashboard

Folder Support

· Identical access rights as the Manager

Folder Reader

· Read all information within own and underlying levels

Roles on Portfolio Management
Role

Rights

Portfolio Management Coordinator

·
·
·
·
·
·
·
·

Portfolio Management Reader

· Read access to all data within the assigned level

Create and archive portfolios
Assign managers and readers to individual portfolios
Manage roles at all levels within the portfolios
Access to all portfolios and their data
Create and archive portfolio items within portfolios
Administer portfolio models
Remove and restore archived portfolio items
Assign a project manager when starting a project from a
portfolio item
· Changing the portfolio dashboard layout

Roles within Portfolio's
Role

Rights

Portfolio Manager

· Create and archive portfolio items
· Assign managers, readers and members as owner to
individual portfolio items
· Access to all portfolios and their data
· Create and archive portfolio items within portfolio
· Remove and restore archived portfolio items
· Assign a project manager when starting a project from a
portfolio item
· Changing the portfolio dashboard layout
· Saving portfolio versions

Portfolio Reader

· Read access to all data within the assigned level

Portfolio Members (available as of
release 7.0)

· Can be assigned to individual portfolio items as owner
Note: before being granted access to portfolios,
users first have to be a member of Portfolio
Management

Roles on Portfolio Item (available as of release 7.0)
Role

Rights

Owner

· Add documents to a portfolio item
· Editing all portfolio item specific and custom fields
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Roles within Custom Dashboards (previously known as Portfolio Dashboards)
Role

Rights

Dashboard owner

· Can set the dashboard filter and modify the portfolio
dashboard (views, reports etc.).
Note: The viewing permissions of the dashboard
owner are used to identify the list of projects for the
portfolio dashboard.
A common scenario is to have the dashboard owner
someone that coordinates the portfolio management setup,
or an administrator. By setting the correct dashboard filter,
other users can see the information they need.

Dashboard manager

Dashboard managers cannot alter the dashboard filter but
otherwise have full permission (except to edit project
information as a portfolio dashboard is used for viewing/
reporting). Dashboard managers are allowed to create
views, reports etc.

Dashboard reader

Dashboard readers only have viewing access to the portfolio
dashboard but cannot define additional reports.

Roles on Programmes
Role

Rights

Programme Manager

·
·
·
·
·

Programme Support

· Identical access rights as the Manager

Programme Reader

· Read all information within a programme
· Add issues to the issue log

Programme Member

· Access assigned items within the programme
· Add issues to the issue log

Manage all information within own programme
Edit programme plan, planning, logs, etc.
Edit members
Set the general status of own programme
Modify lay-out programme dashboard

Roles within Projects
Role

Rights

Project Manager and Project Support

·
·
·
·
·

Manage all information within own project
Edit project plan, planning, logs, etc.
Edit project team
Set the general status of own project
Modify lay-out project dashboard

Project Board members
· Read all information within a project
(Executive, Senior User, Senior Supplier)
· Add issues to the issue log
Team member

Roles on Products / Plan Items

· Read all information within a project, except project costs
information.
· Add issues to the issue log
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Role

Rights

Owner

· Add deliverables (documents) to a product
· Add new log items (issues, risks, changes, actions,
quality reviews) related to the product.
· Editing all product specific and custom fields

Reviewer

· Add deliverables (documents) to a product
· Add new log items (issues, risks, changes, actions,
quality reviews) related to the product.
· Editing all product specific and custom fields

Participant

· Add new issues related to the product.
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Roles on Logs (Issues, Risks, Changes, Actions, Quality reviews)
Role

Rights

Owner

· Change all information in a log item
· Assign the log item to another project team member

Creator

· Change all information in a log item
· Assign the log item to another project team member

Project Manager and Project Support

· Change all information in a log item
· Assign the log item to another project team member

Roles within Resource Management
Role

Rights

Resource Management Coordinators

Has the following rights on all Resources within all
underlying organisational units:
· Defining resource availability
· Allocating project and non-project work

Resource Management Reader

Has the following rights on all Resources within all
underlying organisational units:
· Access to all resources on the underlying organisational
units.
· Reader access to all allocation requests, time
allocations, and availability data

Roles within Benefits Management
Role

Rights

Resource Management Coordinators

Has the following rights on all Resources within all
underlying organisational units:
· Defining resource availability
· Allocating project and non-project work

Resource Management Reader

Has the following rights on all Resources within all
underlying organisational units:
· Access to all resources on the underlying organisational
units.
· Reader access to all allocation requests, time
allocations, and availability data

Principal Toolbox 8.0
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Entering and changing data
To enter and change data, you will always have to click the Edit (
) button. If you have the user rights
to edit data and the page contains editable fields, you will always find this button on the page you are at.
When creating new log items, like issues, risks etcetera, you will directly enter the editing mode, so you
won't have to click edit.

2.8

RAG indicators (traffic lights)
On dashboards of folders and on your home page, the status of projects is shown with RAG indicators.
These indicate the actual status on a folder, project, or product.
The red, amber and green indicators are used in respect to the status of the enterprise, folder, or the
project.
For projects, indicators are shown for:
- General status : Set manually by the project manager to give the general
status.
- Planning status : Based on the tolerances of the folder / project list. Uses
overdue.
- Cost status
: Based on the tolerances of the folder / project list. Uses
expected costs from the budget.
- Hours status : Based on the tolerances of the folder / project list. Uses
expected spent hours from the budget.

(red)

- Major deviation from the plan on costs, hours or planning.
- Based on the tolerances set.

(amber)

- Minor deviation from the plan on costs, hours or planning.
- Based on the tolerances set.

(green)

- No deviation from the plan on costs, hours or planning.
- Based on the tolerances set.

opinion about project
the number of products
the deviation of
the deviation of

The tolerances on the folder can be defined by the folder manager at the dashboard of that level. These
tolerances can be set in percentages or in absolute numbers.
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Tolerances can be set on the folder level

The use of indicators within projects is explained in the following section
a folder or project list see: Setting tolerances 75

2.9

80

. For setting the tolerances in

Views
Throughout Principal Toolbox, views are available to present information in a tabular form. On all
organisational levels (e.g. enterprise, folders, project lists) and within projects (on all logs and the ‘Plan’
and ‘Report’ tab) views are used.
The Principal Toolbox contains predefined views that are generally useful, but it is also possible to define
your own views for your personal purposes. All views can be used for monitoring progress or in
automated reports 174 .

Use the drop-down list as shown in the picture above to select available views. With the View Options
drop-down menu you can define your own view and set options for views.
Note: on the Reports tab, you can choose the object you want to see information about in your
project: Products, Cost/hour entries and Resource assignments are options.
Note: Resource assignments are only available when the add-on Resource Allocation 152 is
available within your organisation.
The different options in the View Options menu are:
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Set filter
Set columns
Set widths
Advanced

:
:
:
:

Make default
Save view
Manage views

:
:
:

Define a filter to make a selection of the shown products / issues / etc.
Add or remove columns from the view.
Set the column width, so the view fits better on screen or in a report.
· Define calculations on certain columns.
· Show or hide column names
This sets a view to the personal default.
Save the view for later use.
Set properties for the view. You find more information at 'Manage views
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'.

Note that on some pages not all functions are available for use. The following example illustrates how to
define a view on the ‘Report’ tab. The view will show all finished products and totals of budgeted and
actual hours and costs.

1. Go to the ‘Report’ tab.
2. In this example we will add a filter that shows all finished products in
the project. Since we want to see a list of products, we choose
Products in the left hand side of the window.
3. Click Set Filter in the View Options menu.
To select finished products set the field ‘Final Status’ to ‘true’. After
clicking OK you get a view of the selected, finished products.
4. With Set Columns you can add and remove columns from the view.
· To add columns to the view, select them on the left side in
column 'All fields'. Click the >> button to add the columns.
· To remove columns from the view, select them on the right
hand side and click << to remove.
· Set the order of columns with the up and down buttons.
You can also set the Sorting order of the view. The field ‘Complete list’
will show you either 50 results per page or the entire list on one page.
5. Change the column widths with the Set Widths option. Drag the line
between columns to increase or decrease the column size.
Note: If you would lik e to use your ‘own’ views for reporting you will
have to tak e into account the maximum width of a page. The
columns may not be wider than the portrait or landscape headers.
Otherwise the table will be too wide for the page.
How to create your own report templates is described in the
section Automated Reports 174 .
Note: the bars for portrait and landscape are of approximate size.
Check the result in your reports.
6. To show totals of numerical fields click the ‘Advanced’ option, and
select the columns for which you would like to know the totals. Click
OK.
7. If you want to save the newly defined view you need to save it with
Save View. To overwrite an existing view you saved before, select the
name of this view at the Existing view pull down list. To create a new
view enter the new name at 'New view'. Click Save to save the view.
8. Select personal, local or global. See manage views for more
information.

Principal Toolbox 8.0

Basics Principal Toolbox

30

9. With the ‘Make Default’ option a specific view can be set to the
personal default view on that page
10.With the button ‘Manage Views’ the views available can be managed.
See Managing views. 30
Tip: If you define a (new) view as standard with the ‘Make Default’ button, the view will be shown when
opening that tab.

2.10

Manage views
Within the Principal Toolbox all users are able to define (personal) views of the information presented on
the different report pages.
As already explained in the previous section, views can be defined on the different levels (e.g. enterprise,
folder), on all logs and on the ‘Plan’ and ‘Report’ tab.
With the Manage Views option, which is available on all mentioned pages, you can manage these
views.

1. Go to a page where views can be defined and click Manage Views.
2. A window will pop-up which lists all available views for this page. This window shows all available
views.
Built-in views
Global views
Local and personal views

:
:
:

Predefined views which are standard within the Principal Toolbox.
Global views defined by the organisation.
Project or user specific views

The settings for the global views can be modified by the system administrator. The settings for the local
and personal views can be modified by the user who has created the view and the system administrator.
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List of views

3. To modify a view, click the name of the specific view. The built-in views can be hidden from the users
of the Principal Toolbox (helpful for views defined only for reporting purposes). To do so click the
specific view and place the tick mark.
4. General and local and personal views have some more options that can be defined;
Name
Remarks
Hidden
Type

: To change the name of the view.
: Add remarks to the specific view.
: Makes a view not visible in the pull-down menu. The view is still available for the
automated reports.
: Select availability for the view:
Global: view is available on all locations (all levels) and for all users.
Local: view is available on the specific location only (e.g. this project only), but for all
users that have access to the location.
Personal: view is available for the current user only but on all location (all levels).

Adding a new view

5. Furthermore, you are able to import and export views. To export a particular view click the 'Export'
button and save the view to your desktop location. To import this view again click the 'Import' button
on the 'Manage views' page and select the *.ptv file. This view will be added as a personal and local
view. Using the buttons as described above the type of view can be changed.
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6. To remove views from the Principal Toolbox use the remove button.

2.11

Document management
Within the Principal Toolbox you can store documents at various locations. Principal Toolbox will keep
the document in the database, so they will be available to all users with access to the document in the
Principal Toolbox. It is possible to overwrite older versions with newer ones. The Principal Toolbox will
keep the old versions in storage. These will remain available for the manager of the particular level in the
tool.
Note: As of release 6.5 it is possible to drag and drop documents from your local computer onto
document lists within the Principal Toolbox
On top of that, it is possible to put an approval cycle on deliverables and/or documents with the add-on
‘Advanced Customisation & Workflow’. See Document management and approval 104 for more
information about storing documents in Principal Toolbox.

2.12

Email function
From almost any page in Principal Toolbox you can create email messages. These messages will
automatically be addressed to the relevant team members, or e.g. the owner of log items etc. The
message itself will contain summarised info about the page you created it from, and a hyperlink to the
page in Principal Toolbox.

1. Click the email button, in the upper right
hand corner of a specific page. In this
example a new issue is created on the
Apollo project and we want to inform the
members of the new issue.
2. A new page will appear with a short
description of the item (in this case:
issue 12). You can select the project
members you wish to notify. These can
be inserted manually or by clicking To,
CC or BCC.
3. Check the default contents of the
message. You can make changes to it
as you wish. Be careful to let the
hyperlink intact, since this is very
helpful to the recipient(s).
4. When finished, click Send e-mail and
the mail is sent to the recipients.

Note: Since the email is sent by Principal Toolbox itself, the message will not be stored by your
normal email software. For this reason, you get a 'BCC' of the email message.
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Search function
Quick search
As of release 7.0, the application provides a quick search option in the header of each main page to find
and navigate to items quickly. By clicking the search box, the recently navigated items are shown and a
search can be performed after typing a minimum of three characters.

Initial search box

Search results

Advanced search
The advanced search function allows you to perform keyword searches. You can also use the
creation period to specify the period when the item was created.
The search function can be found on all dashboards and on the home page.
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Advanced search page

2.14

Messaging
Messaging allows all users to freely inform and discuss topics related to items in the Principal Toolbox.
Note: This function is only available as of release 7.0 and when provided by Fortes Solutions via
SaaS (or hosted).
Two types of buttons exist
This button is shown on all locations within the Principal Toolbox and allows to send/read
messages concerning that location.
This button is shown next to your person name in the header and allows to send/read messages
that concern you.
On click of the button, the messaging dialog appears as shown below.
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Message dialog with content

Initially, the dialog will invite you to send a message. The location to which the message will refer is
already set in the message using the #-tag.
Within the messages you type, you are free to refer to other locations and persons as well using the #and @-tags.

#
@

Use this tag to refer to locations within the Principal Toolbox. After typing three or more
characters, the system will provide matching options. Locations are referred to by name only.
Use this tag to mention other persons that will see the message within their personal
messaging. Persons are referred to by their name only.

Once messages are available, they are shown within the dialog (1) and the unread indication shows for a
short time after the message is considered read. You are able to reply to a certain message by the
message button (2) shown in the right-corner of the message. When doing so, the current message will
be started with all the #- and @-tags of the original message to ensure it pops up at all appropriate
locations.
If, at any location, a message is not yet read by you, a unread indication will appear:
One message is unread, open the messaging dialog to read this message.
Up to five most recent messages appear in the messaging dialog. Older messages can be viewed using
the 'Load older messages' button.

2.15

Working with models
In Principal Toolbox, many objects, e.g. projects, are based upon a model. Such a model defines the
initial configuration and content for the objects that are created upon them. The way this works is
comparable to templates for documents, only models contain not only templates but define configuration
(behaviour) and content as well.
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Models ensure that the same standards are used throughout the organisation. Multiple models may exist
within a single application although it is recommended to keep the number of models limited to be able
to efficiently control and maintain the way of working within the organisation.
Models currently exist for the following type of objects:
· Projects 77
· Programmes 70 (based on MSP or old Programmes)
· Portfolio's 40
Models typically look identical to the type of object it defines, e.g. a project model looks like a normal
project. The difference is its behaviour: it will not appear in reports and some functionality will not be
available (e.g. a project model cannot be used to allocate resources).
A model can be created upon an instance of the object, e.g. a project model can be based upon a
normal project. When doing so, the configuration and basic content is copied and stripped to the model.
Typical information that remains available:
· main object structure (e.g. planning) and their naming
· templates
· configuration
Other information like owner, planning dates, issues etc. are stripped. Once created, a model can be
modified just as its normal object type.
When creating an object based on a model, all information is copied and no data is stripped.

Configuration inheritance when working with models.

For configuration it works differently as depicted in the figure above. This illustrates that configuration can
be made within a project but if non is set, it defaults to the project model configuration. Again, if no
configuration is set on the model, it defaults to the system defaults. This works for all type of models
(project, portfolio etc.).
Models can be exchanged between different applications using import / export functionality.
Note: Exchanging models between applications with different version of the Principal Toolbox
may result is strange or erroneous behaviour. It is best to exchange models between applications
running the same version.
If models are imported into an application on a higher version, the Principal Toolbox will update the
project model version when possible.
Projects
All projects that have been created are based on a project model. A project model is an extensive
template for projects. It contains products, document templates associated with these products, lessons
learned, and automated reports. This way, it is possible to have standardised projects throughout the
organisation, and project managers always have the right document and report templates available. Right
from the start of the project, automated reports (if configured correctly) are available for reporting
purposes. Below, an example of the dashboard of a project model is shown.

Principal Toolbox 8.0

37

Basics Principal Toolbox

Part of the dashboard of the PRINCE2 project model, which is identical to a project dashboard.

It is possible to have multiple project models within your organisation. So you can have a default
PRINCE2 project model for general use and more specialised project models with specialised content.
For instance, a project model for sales or for software implementation. For these purposes, you are able
to build a product breakdown (see the section about product breakdown 84 ) that matches most
situations for these specialised projects. When starting a project based on one of the models, you are
able to adapt the product breakdown to fit the specific circumstances of the project.
More information about the creation and management of project models can be found in the section
Managing project models 129 .
folders
folders are used within the Principal Toolbox for structured organisation of projects (hierarchy) in which
folder Models 71 are used.
More information about the use of folder models can be found in the section folder Management

70 .

Portfolio's
A portfolio model contains automated reports, pre-defined project sheets, reporting models and a
financial model. It's possible to define multiple portfolio models for different portfolios. Please refer to the
section about the Portfolio Model 63 for information about setting up and configuring portfolio models.
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Advanced Customisation & Workflow (add-on)
With the add-on ‘Advanced Customization & Workflow’ an organisation can define electronic forms in the
different project models. These pages can be tailored to the specific needs of the organisation or folder.
1. Go to a project model and create a new product to customize or select an existing product.
2. Click the product to open the product details page.
3. First click "Layout" then click "Edit Layout" to define the layout of the page.
Default layout
Custom layout

:
:

Standard Principal Toolbox view;
To choose which fields are visible on the product page.

Product page

4. Next step is to define which fields need to be available on the page. In the first pull-down menu select
if the field is a project field (e.g. project name) or a product field. Then select the field to show on this
custom product page.
5. The last action on the page is to select what field will be set when all the reviewers approve the data
on the product. In the example given, a custom product field (product approval) is used to set on
approval.
6. In this example a new page with approval cycle is defined. Click 'Approval Settings' and check
'Enable product approval'.
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7. When this project model is used for a project, the project manager (or the owner) inserts data on the
product and then requests approval for the product by clicking the 'Request Approval' button.
8. A new window will open where the approvers need to be selected, a due date can be set and remarks
can be inserted. To send an email to the approver(s) about this product approval, tick 'Notify
approvers’.
9. The approver(s) will be informed through an email and will have a note on their ‘Home’ page.

10.To review the product page click the product name and the specific ‘Product’ page opens.

Approve or disapprove the product

11.After review click ‘

’ or ‘

’ and insert any remarks.
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Portfolio Management (add-on)
The Portfolio Management module enables the collection of initiatives and a subset of an organisation’s
projects and folders. Additionally, the module provides functionality to monitor progress of the projects
and folders within the portfolio, and to generate various portfolio related reports.
Various portfolio’s can be created, in order to get meaningful collections of related folders and projects,
e.g. a portfolio of projects that have the same sponsorship or all projects that contribute to the same
strategic goal(s).
To work with portfolio management, the following activities are of importance:
-

Defining new portfolios 46
Administering portfolios 49
Managing portfolios 52
Creating a portfolio model 63

These subjects will be covered in the sections below.

3.1

Registering ideas
As of release 7.0 it is possible to register ideas within portfolio management.
Note: As of release 8.0 ideas are registered per individual organisational unit.
The ideas allow to collect any idea for projects, possibly contributing to benefits 59 , without the need of
starting an initiative within a portfolio. By doing so, selections and appreciations can be performed before
starting an initiative.
Note: Ideas share the same (custom) fields as portfolio items and projects. Additionally, ideas
have an owner who is allowed to edit, extend the idea information.
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Indication of ideas on portfolio management dashboard

By clicking the ideas widget or the new tab (Ideas) the page refreshes to the list of ideas.
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List of ideas

Ideas can be added, removed (1) and edited (2) as is common within the Principal Toolbox.
By clicking an idea, the details are opened and can be edited. The page layout of the ideas is set by
using the page layout editor (3) in the same way as defining a project sheet 63 (available to managers
and administrators only).

Detail page of ideas

Within the detail page, default (1) and custom (2) fields can be edited as well as documents added or
removed (3).
Once an idea is approved (procedure to be defined within the organisation), an initiative can be started
within a portfolio.
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Start initiative based on idea within a portfolio

On starting the initiative, information from the idea is copied to the initiative (excluding documents).
The idea itself does not change and remains available.

3.2

Working with portfolios

3.2.1

Portfolio overview
A portfolio allows a portfolio manager to group portfolios in providing a clear overview.
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Portfolio Dashboard

1. Customisation area for widgets
This section displays overall portfolio information based on widgets. The information can be altered by
the administrator and configured by the portfolio manager by using the 'Edit Widgets' button.
2. Automated Reports
Displays a list of the Automated Reports

174

that are available on the selected portfolio.

3. Reports
Shows the different categories of reports which can be used to show lists of projects, products, issues
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etc. for the portfolio items contained within the active portfolio.
4. Timeline Reports
Displays a list of the timeline reports that are available on the selected Portfolio. Timeline reports allow
the user to display data over a certain period, like cost information. The horizon and resolution of the
table or graph can be set by the portfolio manager.
5. Report Models
The reporting of project data to the portfolio manager is based on a report model. Each portfolio can
have multiple report models to support different reporting cycles, for example: a monthly highlight
report and a detailed reporting model for each quarter.
6. Previous Versions
Lists all the previously saved versions of the Portfolio. This allows the portfolio manager to go back in
time and compare the portfolio's status between versions. The latest status of the portfolio is saved by
using the button 'Save as version'.
7. Portfolio item
This list contains the portfolio items and buttons for all the actions that can act on the individual (or a
selection of) portfolio items. Some of the actions are 'Save as version', 'Send report request' and
'New'.
8. Tabs
Each portfolio contains the same tabs. Which tabs are shown may depend on the organization's
license: the presence of some tabs is linked to the availability of a certain module. The purpose of
each tab:
Dashbo : as per the detailed description above.
ard
Properti : lists all the basic information of the Portfolio, including any custom fields.
es
Financi : the financial overview tab displays the entered budgets, actual costs and the forecast.
als
Portfolio: shows all the portfolio items in a Gantt based on their start and end dates.
Gantt
Docum : a common repository for all documents relating to the portfolio and their items.
ents
Archive : lists all the archived portfolio items, and allows for items to be deleted or recovered from the
archive.

Portfolio functions
A large number of actions can be performed on the portfolio:
Edit
: allows for editing the name, objective, the status and status description of the portfolio.
propertie
s
Edit
: to change who gets full or read access to the portfolio.
member
s
Customi : for customizing the introductory text on the portfolio's dashboard.
ze Page
Text
Edit
: the field configuration determines how data needs to be synchronized between project and
Field
portfolio item.
Configur
ation
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Project : edit the page layout of portfolio items, letting the portfolio manager determine what fields are
Layout important and how to display them.
Edit
: Add and edit widgets on your portfolio dashboard.
Widgets

3.2.2

New portfolios

3.2.2.1

Defining new portfolios
The portfolio management module allows you to manage your business projects and ideas in portfolios.
In order to do this, one or more portfolios need to be defined. For example a portfolio for every business
unit or regional department in your organization, or a portfolio could consist of all projects that contribute
to a strategic objective of your organization.
Defining a new Portfolio
1. Navigate to the Portfolio Management module in the dark blue header on the top of the screen. In the
main window the Portfolio Management module is displayed, with three tabs: “Dashboard”, “Archive”
and “Models”. The tab “Dashboard” is opened by default.
2. Click + on the dashboard to define a new portfolio. A popup window will appear in which de details of
the new portfolio can be entered.

Portfolio listing

3. Click OK. You will now return to the portfolio dashboard where all portfolios are listed, including the
new portfolio you just created.
3.2.2.2

Portfolio items
When opening the Portfolio Management module, which is found in the top blue bar at the top of the
screen, an overview of all portfolios is shown. Click on the name of one of the portfolios to open it.
A portfolio contains portfolio items of which there are various types:
· Initiative: a business idea that may well be turned into a project in the future
· Single Sheet Project: a simple type of project without detailed plan
· Project: a standard project with a plan, which is managed using the project management side of the
Principal Toolbox
A portfolio item can be used to store management information like the budget, information about
resources, planning information, and the goals of the project. How to create a portfolio item is explained
in this section: Creating portfolio items 47 .
Each type of portfolio item has its own icon:
Initiative:
Single Sheet Project:
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Project / Programme:

3.2.2.3

Creating portfolio items
Note: As of release 8.0 it is possible to start projects on a selected date.

From inside a portfolio, new Ideas, Single Sheet Projects and regular Projects can be created which
become part of that portfolio. A regular Project that is created and started from a Portfolio will
automatically appear as a project on the Project Management side of the Principal Toolbox. However, a
Project that was started from the Project Management module, will not automatically be associated with
a Portfolio. To put a link in place between an existing Project and a new Portfolio item, please refer to
'Modifying the project reference' 49 .
When using the Portfolio Management module it's good practice to always create and start projects from
within a Portfolio. This way it's guaranteed there's always a link between each Portfolio item and its
corresponding Project. This way of working can be enforced by the Principal Toolbox. By enabling this
setting it will prevent any project from starting without having been assigned to a portfolio.
To enable this setting:
1. Click on Setup and select Configuration.
2. Click on Principal Toolbox on the left side of the screen.
3. Change the setting 'Projects can be started from within portfolios only' to Yes
Up next are detailed instructions on the various ways projects and initiatives can be created and started.

Creating an Initiative
1. Open a portfolio and click on + to create a new entry in the portfolio.

Starting a project on the portfolio

2. Enter a name for the Portfolio Item, and the objective and remarks (optionally).
3. Assign a Project Manager to the new portfolio item (in case the portfolio item is converted to a
project later on, the project will be automatically assigned to the project manager specified here).
4. Do not start a project: an Initiative is just an idea without an actual project being underway.
5. Click on OK to create the portfolio item.

Note: in case an existing Project needs to be associated with the newly created Initiative, then
please follow the steps above followed by the instructions in Modifying the project reference 49 .
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Starting a Project when creating an Initiative
1. Follow the same procedure as when creating an Initiative (see above), but choose for Start Project
when entering the details.
2. Next, choose the Project Model the new project should be based on, and choose a folder the new
project will be made part of.
3. Select a start date for the project.
4. The new project will automatically appear within the Project Management module. The Project
Manager will have full access to the new project and can start entering a plan and team members as
required.

Starting a new portfolio item (and project)

Note: The newly created project will appear in the Project Management Module of the Principal
Toolbox. It will be assigned to the project manager (as chosen when creating the Initiative) and is
associated with the portfolio item.

Starting a Project from an existing Initiative
1. Open the portfolio item (initiative) and click on the button 'Start Project' to start a project
2. Choose which Project Model to use, and in which folder the project should be created
3. After pressing OK the Project will be created. The icon of the portfolio item will have changed from
in to

depicting that the Project has started.

Starting a Single Sheet Project
1. To create or start a Single Sheet Project one follows the same procedure as when starting a regular
Project, but when selecting the project model specifically choose the Single Sheet Project model.
2. Then choose the folder in which to create the project and press OK
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3. The Initiative is now associated with a Single Sheet Project that is also visible to the Project Manager
from the Project Management module.
Note: the Single Sheet Project model is a simplified version of the regular project models.

3.2.3

Portfolio administration

3.2.3.1

Moving portfolio items
Portfolio items, whether they're Initiative or Projects, can be moved between Portfolios. This is achieved
as follows:
1. Inside the portfolio that contains the item that needs moving, highlight the portfolio item and press
'Move'.
2. The window that appears allows you to select the destination portfolio.

Moving a portfolio item

3.2.3.2

Modifying the project reference
Running projects that have not been assigned to a portfolio, are not visible from the Portfolio
Management module. They can be added to a portfolio by creating a new portfolio item and manually link
it to the existing project. Follow these steps to establish the link:
1. Open the portfolio item (initiative) and click on the button 'Edit Project Reference'
2. Select the project that the portfolio item needs to be linked by typing the first few characters and
choosing the correct one
3. Click ‘OK’ to establish the link
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Editing the project reference

3.2.3.3

History log
One of the tabs off the dashboard of each portfolio item is labeled History. On this tab a history is
recorded of all changes that have been made to the portfolio item through time. It makes it possible to
check who made which changes when.

History Tab on a portfolio item

3.2.3.4

Portfolio documents
Documents can be attached to the portfolio items or to the portfolio itself. The latter may be useful in
cases where the document is applicable to all (or most) portfolio items.
To attach, update or remove documents from the portfolio, navigate to the Documents tab from the
portfolio dashboard. This will open the document library and show all the documents stored within the
Portfolio. Where each portfolio has a library, the Enterprise level also has a library which can be used for
centrally storing documents.
For more information on document management with the Principal Toolbox, please refer to Document
management and approval 104 .

3.2.3.5

Portfolio archive
A portfolio and each individual items can be archived by pressing the button 'Archive'. Those portfolios
or portfolio items that are selected when pressing Archive will be moved from the active list in to the
archive.
The archive and all the archived items are accessible through the Archive tab on the dashboard. The
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archived portfolios and items can be restored from the archive when required.
Please be aware that archiving a portfolio or one or more of its items does not also archive the projects
that are associated with them. If the projects need to be archived as well, this needs to be done from the
Project Management module.
3.2.3.6

Versioning
To keep a record of historic portfolio data, the Principal Toolbox allows the user to make a snapshot of a
portfolio in time. By doing so, the current version of the portfolio is kept and at a later time, it can be
compared to other snapshots or to the current version of the portfolio.
Creating a snapshot
1. Open the dashboard of the portfolio
2. Use the 'Save version' button to create a snapshot of all portfolio items within the portfolio
3. Give the version a name and optionally some notes and press OK.
The stored versions of the portfolio are displayed on the dashboard under the 'Previous versions' section.
A saved version can be opened and referenced by clicking on its name.

The 'Previous versions' section on the portfolio dashboard.

Note: it is possible to generate reports based on data of previous versions of portfolios. That way
it is possible to compare and analyze the data through time.
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Email notification
Use this button to send an email to the project manager of the project from within the portfolio. For
example, this could be used to remind the project manager to fill out the pending portfolio report.
3.2.4.1.1 Requesting reports

The Portfolio Management module allows one to introduce a periodic reporting cycle. The report is
requested from the Portfolio side and appears on the project where the project manager can fill it out.
Once the Project Manager publishes the report, it updates the information within the portfolio which
allows the portfolio manager to stay up to date with the project status. For setting up such a report
model, please refer to the section 'The reporting model 64 '.
When a report model has been set up, it can be used to request status information on the projects that
are part of the portfolio.
Requesting a report
To send a reporting request to the project manager, please follow these steps:
1. In the opened portfolio, select one or more projects (portfolio items linked to projects). Selecting more
than one project at a time can be achieved by using the shift or control button while selecting. Once
selected, press the 'Send report request' button. A window will appear in which the report properties
can be chosen.
2. Specify the due date for the report, followed by the report model it should be based on, and if required,
send some additional instructions or remarks with the report request.

The report request will be send to the selected projects
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3. If required, the project manager can be send an additional email as a notification that a report request
has been submitted. To have an email sent, just tick the box 'Send notification by e-mail'.
Writing and submitting a portfolio report
Once the report request has been submitted, the report itself will appear on the 'Portfolio Report' tab of
the project. To fill the report out, the project manager follows these steps:
1. From the project dashboard, the project manager opens the 'Portfolio Report' tab and presses the
'Edit' button.

The report can be filled in by project managers, after which it can be submitted to the portfolio manager

2. The project manager then fills out all the fields that are editable. Not all fields will be editable: some
may be automatically calculated.
3. Next, financial information (mostly forecasting) is updated.
4. When done, the project manager presses the 'Save' button, followed by the 'Publish to Portfolio'
button.

Monitoring the report status
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From the portfolio, the portfolio manager can monitor the status of the report requests that were sent
out.
Note: it may be necessary to add the field 'Report Status' as a column to the active view on the
dashboard.
The status of the latest report request is identified by these icons:
Report request pending; hasn't been submitted yet
The report request was received and the report has been submitted
Report request pending; report submission is overdue
As soon as a portfolio report has been submitted by the project manager, the data on the portfolio item is
updated with the latest data as provided by the project manager.

The dashboard shows the status of the report request

3.2.4.2

Financials
Each portfolio can be used to generate financial overviews based on the individual portfolio items. The
financial overview gives insight into budgets, actual and committed costs, and the latest financial
forecasts. The financial overview is found in different places within the Principal Toolbox. These are:
· The 'financials' tab on each portfolio item
· The 'financials' tab on each portfolio, which gives an overview of all portfolio items contained in the
portfolio
· The 'financials' tab on the portfolio report, which is found on the project once a report has been
requested (it's the information entered here that's used to populate the tabs on the portfolio and its
items).
The financial overviews can be configured in many ways to suit different needs. Please check 'Financial
configuration' 67 for more details on how to configure the financial overview.
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The financials overview on the portfolio

3.2.4.3

Portfolio Gantt
Each portfolio dashboard contains a tab 'Portfolio Gantt'. The Gantt chart shows the start, end-date and
duration of all portfolio items within the portfolio.

The portfolio Gantt

Using the Gantt, dependencies between portfolio items can be defined. In order to do so, follow these
steps:
1. Press the 'Edit' button
2. Click and hold the button down on one of the bars.
3. Then drag the cursor to one of the other bars to make an arrow appear.
4. Drop the arrow onto one of the other bars to create the dependency.
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Note: to remove a dependency, right-click on the arrow and choose one of the 'disconnect' options
that appear.
From within the Gantt, the start and end date of the portfolio initiatives (not currently active projects) can
be changed as well. Just click on the start or end of one of the bars, and drag it to the required date. The
same can be done by entering the dates on the left-hand side in the date fields.
3.2.4.4

Stakeholder reporting
As of release 7, it is possible to create special dashboard reports that can be used for stakeholder
reporting. Dashboard reports are available upon portfolio's and saved versions within a portfolio. Note that
on a portfolio the dashboard report will show dynamic data whereas the reports will show static data on a
portfolio version (from the specific version).
Note: Configured dashboard reports on portfolio are copied to saved versions
Dashboard reports are entirely built upon widgets and can be sized, placed and reordered in any way
needed.
To access dashboard reports, navigate to a portfolio and then click on the tab 'Dashboard Report'.

Edit dashboard report

To create or modify the report click 'Customise Report'. After that, you can (1) add new widgets, (2)
choose what type of widget to place, (3) resize and relocate the position of the widgets.
Widgets can also be removed and configured as normal.
When the dashboard report is created, you may notify your stakeholders.

Principal Toolbox 8.0

Portfolio Managem ent (add-on)

57

Notify stakeholders

Selected recipients will get notified that a report is available. If this user has a registered tablet
application (installed and used), the reports will appear on their tablet (iOS and Android).

Dashboard report on tablet (Android)

3.2.4.5

Generating reports
To keep on top of all projects and items within the portfolio, various reporting capabilities are available.
· Automated reports: these are reports based on Excel or Word. The reports allow for flexible and
powerful ways of extracting and summarizing information about the portfolio. Please refer to Automated
Reports 174 for more information on setting these type of report up.
· Reports: these type of reports are contained in the Principal Toolbox and can be used to show table
structured overviews of the different entities in the tool, for example products, risks, issues or cost
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entries.
· Timeline reports: displays an overview of data across a period of time. For example the costs per
month over the duration of the project, or the number of hours a resource has been allocated to the
project for the next period. More information on setting up timeline reports can be found in Timeline
reports 170 .
3.2.4.6

Scenario Planning
As of version 7.5 of the Principal Toolbox it is possible to plan multiple scenarios.
This can be done by navigating to the appropriate portfolio, tab 'Scenario planning'.
You will then be directed to the scenario planning overview.

The scenario planning tab

On the top are two graphs. The first is the budget and risk chart displaying 'Return On Investment' and
'Budget' on the axis and 'Risk' is depicted by the size of the bubble.
This chart can be configured the same way as a regular bubble chart 188 .
The second graph shows the forecast for the coming months and is based on the timeline widget.
This chart can be configured the same way as a regular timeline widget 188 .
Below the two charts there are two lists. The first list contains the selected projects and the second list
contains the unselected projects.
Selected and unselecting projects allows for multiple scenarios to be analysed.
Selecting and/or unselecting projects can be done in two ways:
1. Clicking on the appropriate bubble (project) in the bubble chart (un)selects a project.
2. By dragging and dropping a project from one list to another.
The generated scenario's can then be save by clicking

.
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These saved scenario's can be applied to the portfolio by selecting the scenario in the drop down menu and clicking
.

Select the appropriate scenario to apply to the portfolio.

3.3

Benefits definition and tracking
As of release 7.0 it is possible to register benefits within portfolio management and track their progress
related to the initiated, running and/or completed projects.
Note: Benefits have as of yet little built-in fields and will need custom field definitions to
implement definition and track ing possibilities.
By clicking the benefits tab (Benefits) the page refreshes to the list of defined benefits.
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List of benefits and their graphical representation with relations (map).

Benefits can be added, removed (1) and edited (2) as is common within the Principal Toolbox.
By clicking a benefit, the details are opened and can be edited. The page layout of the benefit is set by
using the page layout editor (3) in the same way as defining a project sheet 63 (available to managers
and administrators only).
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Detail page of benefits

Within the detail page, default (1) and custom (2) fields can be edited as well as documents added or
removed (3) on a separate tab.
Each benefit can also be configured to list the contributing projects. This list is defined by a simple filter
to which the projects should match. From these projects, information can be listed.
Note: There is no built-in calculation from contributing projects towards the benefit. If needed,
this should be realised using custom field calculations.

3.4

Using custom dashboards
Custom dashboards are a way of providing a cross-portfolio view on the projects that are running within
an organisation. As an example, this could be used to list all projects related to a specific business unit,
service or product. Within a custom dashboard, reporting facilities are available to create a tailored
reporting model for the scope of the dashboard.
Note: Prior to release 7, custom dashboards were named portfolio dashboards.
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Note: A custom dashboard primarily provides viewing information, it does not allow modification of
information.
To define the projects that will be listed within a custom dashboard, the so-called 'dashboard filter' needs
to be set. Click 'Set Dashboard Filter' and the filter widget appears to define the selection criteria for the
dashboard. Once set, click OK to activate the dashboard filter.

Buttons and dashboard filter

Only the Dashboard owner (or administrators) may set the dashboard filter. Other roles on the custom
dashboard are described in permissions and roles 22 .
A custom dashboard has the same setup as a normal portfolio but lacks following functionality:
Functionality
Create/start
projects

Remarks
A custom dashboard only shows existing (portfolio) projects and does not allow to
create or start new portfolio items/projects.

Report requests

Portfolio reporting is done through the base portfolio of a portfolio item and cannot be
initiated through a custom dashboard.

Saved versions

Portfolio versions (and their portfolio items) can only be done through the base
portfolio. Custom dashboards can filter on saved versions if needed.

Financial
management

Financials can only be viewed through the custom dashboard. Financials are managed
through the base portfolio.

Configuration

Configuration, except for the custom dashboard filter, is not applicable to the custom
dashboard. Configuration to the portfolio items is applied based on their respective
portfolio's.
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Portfolio model configuration
Each portfolio can be based on a portfolio model. Using a model ensures portfolios are configured in one
(or more) identical ways.
Items which are part of the model:
·
·
·
·
·

The page lay-out of the portfolio items
The reporting model
The automated reports (please see Automated reports
The field configuration
The financial configuration

174

for more information)

Note: all of the above items can also be set on each individual portfolio after it has been created

Example portfolio model

3.5.1

Defining a project sheet
The page lay-out of the project sheet, which is shown when opening a portfolio item, can be customized
for each portfolio or portfolio model. The project sheet can be used in displaying the basic project or
initiative properties, including custom fields and status information. The page lay-out is defined by:
1. From the Portfolio Management dashboard, open a portfolio model or one of the existing portfolios.
2. Press the button 'Portfolio item layout'.
3. Press the button 'Edit Layout'.
4. A new windows opens of which the left-hand allows for defining the layout, whilst the right-hand side
contains a list of all fields and properties that can be dragged onto the layout side.
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Editing the page layout

3.5.2

The reporting model
Portfolio reports allow one to define a reporting cycle which allows data to be published from project level
to the portfolio. To allow for this cycle to take place, a reporting model needs to be defined which
specifies what information needs to be captured.
Creating a new reporting model
Each portfolio can contain multiple reporting models. Each model can be used for different reporting
cycles. For example, one model could be used for a monthly reporting cycle and another one, more
detailed report, for a quarterly cycle.
To create new reporting model, follow these steps:
1. From within the portfolio model (or from an existing portfolio), press the button 'New' which is located
in the header bar 'Report Models'.
2. In the new window that appears, enter a name and an objective for the new reporting model.
3. Click 'Save' to save the new reporting model.

Configuring the reporting model
The newly created reporting model uses some default settings. To customize the data that is to be
captured follow these steps:
1. From within the portfolio model (or from an existing portfolio), click on the name of the reporting model
that needs configuring.
2. Click on 'Model Configuration' and select the sections that are to be used in the report (property
section and / or finance section).
3. The 'Properties' section can be configured by pressing the 'Edit Page Layout' button in the 'Layout'
section.
4. The new window that appears contains three sections: the new page layout (left-hand side), the layout
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components (right-hand side, top half), and a list of the available fields and properties (right-hand side,
lower half). The page components and fields situated at the right-hand side can be dragged over the
left-hand side to build a custom page layout to be used in the reporting model.

By dragging fields and page components from right to left, a new page layout can be defined.

5. Press the 'Save' button to save the new page lay-out
6. Besides the 'Properties' section, the 'Finance' section can be customized separately. Please refer to
'Financial Configuration' 67 for more information.

3.5.3

Field configuration
Fields and properties which are used on the project sheet to show information about the portfolio item are
not automatically linked to the corresponding fields on the project. It is possible to set the behaviour
between these fields using the 'Field Configuration' button. Customizing the behaviour between fields is
mostly applicable to custom fields, although it can be changed for some pre-defined fields as well.
Custom fields are added at project level and automatically appear on the Properties tab of the project and
the project sheet of the portfolio items (unless a custom page lay-out has been defined, which means
they have to be manually added). Although the fields at project and portfolio level appear to be the same,
since they're carrying the same name, their behaviour and therefore content may differ.
The behaviour of these fields is defined within the portfolio or on the portfolio model.
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The button 'Field Configuration' is found on the portfolio or the portfolio model, as highlighted above.

The following behaviours can be set for both the project and portfolio fields:
· Fields can be made available or be hidden
· Fields can be made editable or read-only
· Synchronization can be set: either off, or one-directional from project to portfolio or the other way
· Or the fields can be set based on a customized calculation (behaviour set to 'custom')
Note: Synchronization only work s one way! It's either synchronized from project to portfolio or
from portfolio to project, but not both ways.
Note: Only use 'custom' behaviour when told to by Fortes Solutions.
Changing the field configuration
1. From within the portfolio model (or an existing portfolio) press the button 'Field Configuration'. A new
window will appear which contains a list of all project and portfolio fields and their behaviours.
2. Press 'Edit' to change the settings of the fields.
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Field configuration

3. Choose one of the following combination of options on the project or portfolio side:
Settings

Options

Resulting behaviour

No Local Configuration

No configuration applicable

Not Available

The field will not be available for
use at portfolio and / or project
level

Available

The field will be available for
use at portfolio and / or project
level

No Local Configuration

No configuration applicable

Not Editable

The field is not editable at
portfolio and / or project level

Editable

The field will be editable at
portfolio and / or project level

Editable before project start

The field will be editable at
portfolio level up until the
moment the corresponding
project has been created (this
option is only available on the
portfolio side)

No Local Configuration

No configuration applicable

Synchronized

The field will be synchronized
from portfolio to project level, or
the other way around (one way
only)

Synchronized after project
start

The field will be synchronized
from project level to portfolio
level as soon as the
corresponding project has been
created.

Custom

The behaviour of the field is
defined by a custom
calculation as provided by
Fortes Solutions

Available

Edit Level

Behaviour

4. Press 'Save' to save the altered field configuration.
Note that alterations to the configuration is shown in blue. If not altered, the configuration follows the
normal inheritance behaviour:

Inheritance of field configuration

3.5.4

Financial configuration
Within the portfolio, the individual project sheets, and within the portfolio report on the project, financial
overviews can be shown and filled out. The financial overview displays budgets, actual and committed
costs, and a forecast.
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The following items of the financial overview can be configured to suit different needs:
· The behaviour and the resolution of the fields Budget, Actual, Committed and Forecast.
· The financial period that should be displayed (current period, previous period and the period following
the current one)
· The financial categories that should be displayed
· Other display options

Configuration
1. From the Portfolio Management dashboard, open a portfolio model or one of the existing portfolios.
2. Open the 'Financials' tab and press the button 'Finance Configuration'.

Finance Configuration

3. The window that opens allows the financial configuration to be changed
4. Select 'Use custom configuration', which will bring up more settings
5. The following items can be configured:
Financial periods
and / or next financial
Behaviour
Forecasting process
purposes
Financial categories
Display options
attached

:
period
:
:

Set the current financial periods, and whether to show the preceding

:
:

Determine which financial categories will be available for use
Choose whether to show financial categories which have no data

Change who can edit which fields at which point in the process
Define which part of the period should be displayed for forecasting

68

Principal Toolbox 8.0

Portfolio Managem ent (add-on)

6. Adding new financial categories is done from the 'Setup' and 'Configuration', in the 'Financial
categories' section. This can only be done by an administrator.
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Creating financial categories

4

Programme Management (add-on)
As of release 8.0 of the Principal Toolbox there is a new programme management
functionality.
This functionality is provided as a programme management model.
Programme management provides modern functionality and reporting and links to portfolio management.
It facilitates large scale organisational changes.
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The programme management dashboard

4.1

Programme Management Model
Navigate to the project management folder, tab 'Models'

Overview of the available models
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Click the folder model to open it.

Programme Model dashboard

In the project model all standard properties, roles, documents, etc. can be configured in the same
manner as for project 35 and portfolio 63 models.

4.2

Integrated Programme Management
Within a programme it is possible to create a planning, including projects and their deliverables.
Projects within the programme plan can be:
· Identified without requiring a full blown operational project
· Started as a full blown project with the planning set to a certain date
· Contain deliverables identified by the folder manager
· Have dependencies with other plan items in the folder plan
Identified projects (initiatives) can be planned and started from within the folder. When the project is
started, the project manager defines the detail planning.

Programme Dashboard

In the Programme project Gantt initiatives are shown in a 'lighter' shade.
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Programme project Gantt

Programme projects can be started from the projects’ detail page (on the program plan).
On starting the project, the planning (as contained in the project model) can be moved to a certain date.
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Starting a programme project

4.3

Programme to Portfolio reporting
Programmes can be started from a portfolio (just like projects) and have the same reporting cycle as
projects currently in a portfolio.
Programmes will typically include/summarise the data from underlying projects extended with the folder
status information.
Programme managers publish summarised statuses to the portfolio.
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Program status report

On the portfolio, an integrated view exists of all portfolio items (initiatives, folders and projects).

Integrated view of all portfolio items

4.4

Setting tolerances
Tolerances are used to monitor project status. At the start of the project, the project manager and project
board agree on the tolerance for the project. Tolerances are the allowed deviation in time, quality, costs
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and hours from the planned values. When a project exceeds the agreed tolerances, according to project
management methodology it needs to be reported to the project board. In Principal Toolbox, this can be
made visible with the RAG indicators on any folder dashboard.
Note: tolerances need to be set for each project list and folder separately. They are not inherited
from higher levels.
Tolerances can be set by a folder manger for the folder / project list as a whole and for projects
separately. To set tolerances, click 'Edit Tolerances' on the folder dashboard.

Tolerances can be set for the entire folder or project specific

In the 'folder and project tolerances' window, you can set tolerances for the following four categories.
· Stage
:
Shows whether or not the active stage is running behind or on schedule with
respect to the planning end date.
· Planning
:
Counts the number of products that are overdue (final planned date before today
and product is not finished).
· Hours
:
Compares the spent hours (committed + actual + variance) with the budget.
· Costs
:
Compares the spent costs (committed + actual + variance) with the budget.
The 'default project tolerances' are used for all projects in the folder. If project specific tolerances are filled
for a project, these will overrule the default tolerances.
- Activate the Project specific tolerances per project by selecting the checkbox in the column Project
Specific Tolerances.
- For the tolerance settings to be active for the current stage select the checkbox in the column
Planning active stage only.
By default you will see an overview of the Stage planning and Product Planning tolerances (as can be
seen in the image above).
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Select the view Cost & Hours Tolerances from the drop down list to set the Cost and Hours tolerances.

Setting Cost & Hours tolerances

For each of these, you can set both absolute numbers and percentages of the total. The colours of the
RAG indicators are set according to worst case scenario tolerances for cost and hours. Example:
Tolerances set:
Costs orange (%):
Costs red (%)
Costs orange (abs)
Costs red (abs)

10%
20%
5,000
10,000

Project costs:
Budget
Committed
Actual
Remaining

100,000.00
25,000.00
65,000.00
23,000.00

So the expected costs for the project are (25,000 + 65,000 + 23,000) = 113,000. The budget is 100,000,
so the expected deviation is 13,000.
According to the percentages set, this would result in an amber (orange) indicator. However, since the
absolute number for a red indicator is 10,000, it will show red on the folder dashboard.

5

Project Management
The Principal Toolbox allows for different project models that provide different approaches to project
planning. As of release 6.5, following project models 1 are supported:
- Single Sheet Project 78
- Classic PRINCE2 Project
- Generic PRINCE2 Project
- Agile Project 124

118

78

For help on project planning, tracking etc. please refer to the classic project planning
instructions for the other models are provided at the appropriate sections.

118

. Special

All type of models can be customised to the needs of your organisation. For help on this topic, please
refer to managing project models 129 .
As of release 6.5, the option exists to migrate classic PRINCE2 projects to generic PRINCE2 projects.
Please refer to project migration 230 for more information.
1

Special models may exist as well within y our setup (prov ided by Fortes Solutions on customer request).
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Single Sheet Project
As of release 5.0 a new project model has been made available. This project model is little more than a
single page (sheet) that contains the most important project information. It is especially useful for
portfolio management by providing a way of letting project managers report project portfolio information on
a regular bases without requiring a full project planning within the Principal Toolbox. It can also be used
to provide a low impact operational project reference that can be converted later on to a full project (with
either classic or generic PRINCE2 planning 77 ).
Starting up a new project with the single Sheet Project Model (also referred to as SSP Model):
1. Go to the Portfolio dashboard and click on New in the ‘Project listing’.
2. Enter the details and select the new project model.
3. Select a project manager and click on OK to create the project.
Project Reporting
The project is now available on the folder and/or portfolio dashboard. If a report request is submitted to
this project, the project manager will typically see this page for the project (with the request to update
and publish the project information). See portfolio reporting 52 for more information.
Note that the Single Sheet Project also allows for basic document management, see document
management 32 .
Apply model
If the project requires a more detailed planning, the project can be converted into a full project by clicking
the 'Apply Model' button.

Apply model for Single Sheet Project

By selecting the required project model and clicking 'OK', the project will be converted to this new project
model. Typically, the project can now be planned in detail, issues and risks tracked etc. See classic or
generic PRINCE2 planning 77 for more information.

5.2

Generic PRINCE2 Project
The generic PRINCE2 project allows for a strict planning according to the PRINCE2 project management
methodology. It does not allow for activity planning, only stages, work packages and products are
supported.
The next sections provide information on using the project:
- Project dashboard 79
- Planning a project 82
- Managing a project 99
- Finishing a project 117
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Most topics apply to other project models as well.

5.2.1

Project dashboard
The project dashboard is one of the most important windows, because it enables the project manager to
monitor the progress of the project.

Project dashboard

1.

Tabs
The tabs are standard for each project. Depending on your organisation's license some tabs might
not be available. The name of the tab indicates the content of the page:
- Properties

:

- Product breakdown

:

- Planning

:

- Resource Management (add- :
on)

2.

- Documents

:

- Portfolio Report (add-on)

:

- Reports

:

Includes all project properties including custom fields and portfolio
information.
A decomposition of the products realised by the project. The tab
gives a graphical representation of the product breakdown 84 .
To set milestones and assign resources to the different products.
Overview of the project's hours and cost.
Graphical representation of the project products/activities and
export functionality to MS Projects (Gantt).
When the Resource Management add-on is available, the Project
Manager is able to request resources from the organisational unit.
It also gives the Project Manager an overview of the requested
and allocated resources.
To manage project related documents the Project Manager can
use the tab ' Documents'. This tab makes it easier to search for
specific documents within a project. The tab gives you several
options to search for documents.
When the Portfolio Management add-on is available and the
Portfolio Manager has requested a report, the Portfolio Report tab
will appear. The Project Manager can update the requested
information on this tab and publish it to the portfolio.
Report functionality about the products, cost / hour entries and
resource assignments of the project.

Logs
It gives an overview of the logs 108 that are used in a PRINCE2™ environment. A counter is displayed
for each log indicating the number of items there are for each log and if there are new items. The log
is selected by clicking the name of the log.
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Automated reports
A list of all automated reports
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available within this project.

4.

PRINCE2™
Here you see the PRINCE2™ process model on which your project is based upon. The stage your
project has reached is highlighted (yellow stage) and you can quickly go to the details of a stage by
clicking a stage.

5.

Product list
Here you find the product planning concerned with the various stages and work packages.

6.

Functions at project level
Here you can compose the project team (Edit members), edit the general project information (Edit
see point 2), use the search function, make a print of the current page, inform the project members
by email and export key project information to a zip file (‘Pack project offline’).

The use of colours within projects
On the project dashboard, colours are used to indicate the active stage, types of products and to draw
attention to potential problems.
Stage colour
The active stage in your project is coloured yellow, the other stages are grey. It does not mean the other
stages cannot be edited, it is an indication and used for filtering purposes in certain views. In the product
checklist, stage names are shown in black. On the Gantt chart, stage bars are also shown in black.
Types of products
Three types of products are identified in Principal Toolbox. Throughout the Principal Toolbox, these are
shown in the following colours:
· Green: products of the project board, mostly authorisations and decision points.
· Blue: project management products, like the project mandate, PID, highlight reports etc.
· Amber: Specialist products. Specialist products are all products that are part of the product breakdown
and define the final result of the project.
Work packages are shown in a bold amber font type. On the Gantt chart, work packages are solid
amber.

Active stage in maroon
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Different colours for different planning types

Indication of potential problems
On the project dashboard, dates are default depicted in black. If a date is either today or in the past, it is
shown in red to draw attention.
In front of the product names indicators show potential problems:

Final planned date has passed.
(red)

(yellow)

(blue)

An inconsistency is present with the product milestones (e.g. start milestone is planned
later than the draft milestone)
Is shown when a conflict arises due to conflicting dependencies. If an end date of a
‘Predecessor’ is delayed or planned later than the start date of the ‘Successor’ a blue
traffic light is shown to indicate a problem.

In the following section, the use of RAG indicators

27

on folder / project list dashboards is explained.
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Planning a project
Project planning within the Principal Toolbox can be done by following these seven steps:
1.
2.
3.
4.
5.
6.

Defining a product breakdown structure. 84
Defining stages and work packages. 87
Planning the milestones of the project. 91
Assign responsibilities for products 89 .
Assignment of budgets (hours and costs). 95
Defining dependencies between products. 96

This sequence is just a suggestion. An iterative planning process is always possible; editing your project
plan and other data remains possible throughout your project.
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Creating a project
Projects are always created from a folder or project list dashboard. To create a new project do the
following:
1.

Go to the dashboard of the folder or project list.

2.

Click the + in the Project listing heading. The window ‘Add Project’ appears.

Creating a new project

3.

Fill in the appropriate data at ‘Project properties’:
Name
: Project name
Objective
: Short description of the project's objective
Project model
: Select the project model on which the project will be based
Product planning : If the add-on Microsoft Project Client Integration is available, you have the
choice to plan your project using MS Project. This adds the possibility
(however much more complexity!) of activity based planning.

4.

Scroll to the ‘Add project members’ section and add the project manager from the list of ‘Available
users’. If known, you can add the other members as well. With the search option a specific user can
be found easily.
Depending on your system settings, this page either shows you the roles project manager, project
board and team members or it will show all PRINCE2 roles e.g. Senior supplier, project support,
project assurance.
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By clicking ‘OK’ the project will be created.

Note: Creating a new project can be done by the system administrator, and manager and readers of a
folder / project list.
5.2.3.2

Defining a product breakdown structure
The definition of a product breakdown structure assists in thinking through the result of the project, i.e.
the final product. The final product of a project is broken down into manageable parts in the product
breakdown structure. These parts are called specialist products and can be both physical products as
well as documents.
Note: Only project managers and project support can edit the project plan.
Stages are edited in the 'Product Breakdown' column on the 'Planning' tab.
Editing the product breakdown structure - introduction
The Principal Toolbox uses three distinct product types:
Specialist Products: use this tab to define the product breakdown structure with amber coloured
specialist products.
Management Products: use this tab to organize the stock of blue coloured management products.
Board Products: use this tab to organize the stock of green coloured board products
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Editing the project breakdown structure

Creating new stages / products is done by clicking the '+' on the left hand side of the screen.
Note: When creating a new item, the '+' item always creates a child instance of the selected level.
A detailed description of how to create or change the product breakdown is given in the next section.
5.2.3.2.1 Creating the product breakdow n structure

Note: Only project managers and project support can edit the project plan.
If a product breakdown is already present, you can choose to either rename and re-order the products in
the product breakdown, or you can delete the products from the present breakdown and start with an
empty list.
· To rename items, double-click a coloured product and enter the new name in the pop-up.
·
·
·
·

To delete products, select the item by selecting the checkbox and click '
'.
To add products, click '+' and type the name of the item.
Change the order of products by dragging them to the right position.
To change the hierarchy, drag the products to the appropriate level. A green arrow indicates at which
level you will drop the item.
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Renaming an item in the Product Breakdown

The setting ‘mandatory’ is part of the product properties and therefore visible on the product page. A
mandatory product within a project model can only be modified by the model owner and within an
ongoing project by the system administrator.
To make a product mandatory, go to the product page of the product you would like to make mandatory.
Click on Edit and check the box that says 'Mandatory'. Then click on Save to save your changes.

Making a product mandatory on the product page

By using this functionality correctly it is possible to increase the uniformity of the work flow and improve
the overall grip on the projects.
How to assign products to stages and work packages is described in the next sections.

5.2.3.2.2 Graphical view of the product breakdow n

After editing the product breakdown, a graphical overview of the product breakdown is shown on the tab
'Product breakdown' in your project.
1.
2.

Go to the tab ‘Product Breakdown’.
On the left (Breakdown representation) you can select the item type (Specialist Product,
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Management Product or Board Product) to set the view. A view similar to the view beneath will be
shown.

Product Breakdown Structure (Specialist Products)

Products which are not assigned are shown in grey (and are not part of the project plan). Products
assigned to a stage and / or work package are shown in yellow (specialist product), blue (management
product) or green (board product).
Assigning products to stages and work packages is described in the next two sections.
5.2.3.2.3 Editing stages

Note: Only project managers and project support can edit the project plan.
Stages are edited in the 'Planning' tab. Before starting, go to this tab.
To start editing click

.

Before editing stages, go to the 'Planning' tab.

Renaming a stage
To rename a stage, double-click its name in the Gantt on the left hand side of the screen.
Adding a stage
To add a stage to your project plan, click the '+' on the appropriate level.
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Adding a stage by clicking '+'.

Moving stages
To move a stage, click its name and drag it to the right position. Check the arrow indicating where the
stage will be positioned.
Deleting a stage
To delete a stage, click its name and click
these will be deleted as well.

. If the stage contains products and/or work packages,

5.2.3.2.4 Editing w ork packages

Note: Only project managers and project support can edit the project plan.
Work packages are used to assign multiple products to the same team (PRINCE2), or as a means of
making a further subdivision in stages. Principal Toolbox uses them to calculate summarised start and
end dates, and subtotals of costs and hours.
Note: empty work pack ages result in errors when the Principal Toolbox calculates progress on the
project dashboard, so only use work pack ages with products inside (see the section planning
products 163 ).
Stages are edited in the 'Planning' tab. Before starting any action, navigate to this tab.
Renaming a work package
To rename a work package, double-click its name (in the Gantt on the left hand side of the tab).
Adding a work package
To add a work package to your project plan, click the '+' and add an item.
Next select the item by clicking on it and click

and select 'work package'.

Moving work packages
To move a work package, click its name and drag it to the right position. Check the arrow indicating
where the work package will be positioned.
Deleting a work package
To delete a work package, click its name and click

. If the work package contains underlying
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items, these will be deleted as well.
5.2.3.2.5 Assigning responsibilities for products

Next step is to assign the responsible owners to the products in your project. This can be done by either
the project manager or project support roles. Before you can assign products to project members, you
have to make sure that all required resources are a member of your project (management) team.
Assemble your project team
1. Go to the ‘dashboard’ tab of your project.

2. Click
to see the members of your project team. To add people to your project team,
select them from the list on the right and click ‘Add’ at a specific role to assign them. Use the search
option to easily find a specific user.
Depending on your system's configuration, this page shows you either the project manager, project
board and team members, or it shows all PRINCE2 roles i.e. Senior supplier, project support, project
assurance, etc. This can be changed by the system administrator.

Edit members; setting 'limited set of roles'
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3. Click ‘OK’ at the bottom of the window to save the changes.

Assign products to owners
1. Go to the ‘Planning’ tab.

2. Click

and select the owner property of the product to assign a product owner.

90
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5.2.3.3

Planning product milestones
Each product in the project has two milestones you can use to manage product delivery.
· Start:
set the date work has to start on the product
· Final:
the planned date for delivery of the final version of the product.
Planning the milestones within the project can be done on the Gantt chart
with ‘drag & drop’ functionality.

91 .

Use the Gantt chart editor

5.2.3.3.1 Using the Gantt editor

A Gantt chart shows a timeline of your product with the product milestones. Because Gantt charts are
simple to understand and easy to construct, they are often used by project managers.
To use the Gantt chart in your project, follow these steps.
1. From inside your project, click the 'Planning' tab. A Gantt chart will be shown with all stages, work
packages, and products listed. When you haven't entered any planned dates (milestones) yet, the
start date of the project will be set to the date of today and the duration of all products will be set
according to the duration in the project model.
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2. To edit the Gantt chart, click

in the blue page header.

Note: To select products in the edit Gantt window, click the product name on the left of the
window. To select multiple products, k eep CTRL or SHIFT pressed while click ing multiple
products.
3. On the next page the planning can be entered in two ways. In the left hand half you can enter dates by
clicking the cells and using the calendars. Alternatively, you can use the graphical part of the window.
Here, you can change duration and dates with your mouse by dragging the time lines of products.
4. First of all you need to define the start date of your project. For more information in starting your
project and adding items to your project see editing stages 87 & editing work packages 88 .
5. Set the date of the first product in every stage or work package by dragging this to the planned start
date or use the button shown above. All products in this specific work package or stage will be moved
automatically to this date.
6. The next step is to plan the products in this specific stage or work package individually:
a. To move the product forwards or backwards in time you need to place the cursor in the centre of the
product bar, hold the left mouse button down and drag it to the correct position.
b. To alter the duration, you need to place the cursor on one of the sides of the product time-bar and
drag the side in the desired direction.
7. To define dependencies between products, select two products and click Add dependency. This will
create a finish-to-start dependency between the two products. To edit dependencies see the section
defining dependencies 96 . To delete a dependency use Remove dependency. Buttons:

8. If dependency conflicts exist in your planning you can use the Solve conflicts button:
the products you want to be recalculated and click the button.

. Select
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After: problem solved

10.When the plan is finished, click Save to save the changes made.
11.As of version 7.5 it is possible to highlight the critical path. To do this click 'Edit', next click 'View'
and select 'Show critical path'.
Note: inconsistencies or conflicts resulting from mutually depending products are indicated by
coloured indicators. For their meaning, consult the use of colours in projects 80 . For more help on
dependencies, see defining dependencies 96 .
5.2.3.3.2 Baseline support

To keep track of progress and changes in the original planning is can be very useful to work with
baselines. It allows you to compare the current schedule with the baseline planning.
Setting the baseline will copy the current product planning to the selected baseline for comparison when
the project progresses.
Set Baseline
In the 'Planning' tab, sub tab 'Gantt' you are able to set a baseline.
To set a baseline click
and click 'Set'.
This saves the current Gantt chart as the baseline for the project.

Choose the baseline type (Initial or Current Baseline) to save the schedule.

Setting a baseline
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View a Baseline
In the Gantt chart a baseline planning can be shown in the current plan. You can choose to show the
Initial or Current Baseline in the actual Gantt.

Selecting a baseline

Baselines on the Gantt

5.2.3.4

Product page
Every product which is defined has a standard product page. In order to consult the detailed information
concerning this specific product you click the product name in the project dashboard.

Product page

On the ‘Product page’ there are some extra tab pages: Logs, Dependencies and Costs & Hours (not
shown). The Logs tab allows you to register items such as: issues, risks and quality review 108 . On the
Dependencies 96 tab you can define dependencies between products to create a product flow.
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5.2.3.5

95

Dependencies tab

Assigning budgets
In the Principal Toolbox, product based planning takes a central place. Budgeting and cost registration is
also product based, so all costs are calculated towards products.
Note: time, stage or project based costing is also possible in Principal Toolbox. In this case,
dummy (management) products are added to the project plan (see planning products 163 ). In the
case of time or project based costing, add the dummy products to the last stage of your project.
This way, they stay visible throughout the project.
For the registration of both costs and hours, five types of registration are available:
· Budget
: The approved budget
· Committed : Costs you will have to pay, e.g. a contract signed, but not yet invoiced
· Actual
: Money or hours actually spent
· Remaining : An estimate of costs or hours necessary to complete the product.
· Variance
: The variance relative to the budget.
Formula: variance = (committed + actual + remaining) - budget

Below you'll find the steps to set the budget for your project.
1. Go to the 'Planning' tab.
2. Sub-tab 'Costs'.

3. Click

and then double click the financial category that you want to assign a budget too.

4. Set the budget and the release date and click 'OK' to set the budget.
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5.2.3.6

Defining dependencies
The easiest way to define dependencies within your project is by using the editable Gantt 91 .
Dependencies created on the Gantt chart are inserted as 'finish-to-start' relationships. To modify the
dependency type or to define dependencies with products from other projects (inter-project
dependencies) you need to open the product details (from the project dashboard or planning) and go to
the 'Dependencies' tab.

1. Click the name of the product you want to create a dependency for, and select the tab
'Dependencies’.

Dependencies tab in the product detail window

2. On this tab you can add ‘Predecessors’, from your project and from external projects. Click Add to
select one or more ‘Predecessors'. Then select the project and the product which are the
‘Predecessors’ and define the type of relation, options are:

96
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Start-tofinish:

Start-tostart:
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Product (B) cannot
be finished until
product (A) has
been finished. For
example, if you
have two products,
"Wiring" and
"Installation
inspected",
"Installation
inspected" cannot
be finished until
"Add wiring" has
been finished.
Work on product
(B) cannot start
until product (A)
has been finished.
For example, if you
have two products.
"Constructed
fence" and "Painted
fence", "Painted
fence" cannot be
started until
"Constructed
fence" has been
finished. This is the
most common type
of dependency.
Product (B) cannot
be finished until
work on product (A)
has been started.
The Predecessor
must be started
before current
product can finish.
Work on product
(B) cannot start
until work on
product (A) starts.
For example, if you
have two products,
"Foundation
poured" and
"Concrete leveled",
"Concrete leveled"
cannot begin until
"Foundation
poured" begins.

3. Click OK to create the relationship.
Note: only predecessors can be defined. This way, a project manager cannot mak e another
project dependent on his or her own project. To define successors, the project managers have to
cooperate.
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4. The type of the dependency and the lag (delay) can be modified on the main page. Lag is a delay
between products that have a dependency. For example, if you need a two-day delay between the
finish of one product and the start of another, you can establish a finish-to-start dependency and
specify two days of lag time.

Adding a dependency

The relationships are verified based on the start and end date of the products. If an end date of a
‘Predecessor’ is delayed or planned later than the start date of the ‘Successor’ and the relation is defined
as; Finish-to-Start, a blue traffic light is shown to indicate a problem.
External dependencies
External dependencies are represented in the projects Gantt diagram. These are represented with a big
dot and the word 'external'. To see details of the dependency; place your mouse on the dependency and
a pop-up screen will show the details.

Dependencies on the Gantt

On programme level these inter-project dependencies are also represented so the folder manager can
see bottlenecks in the execution of the folder.
See the screenshots below:
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Dependencies on the folder Gantt

5.2.3.7

Requesting resources
The Project Manager is able to request resources to staff his project. Resources can be requested as
skill, or, if the project manager has a specific preference, as ‘named’ resources.
How a Project Manager requests resources for his project and how a he or she requests resources van
be found at 'Requesting resources within a project' 162 .
Note: To be able to request and allocate resources, the Resource Alloc2ation module needs to
be available!

5.2.4

Managing a project
During the execution of a project the defined products are to be realised. In this section you will find:
·
·
·
·
·
·

5.2.4.1

How to monitor and enter progress.
How to communicate with the Principal Toolbox.
Ways of composing reports and views.
How documents/templates are managed.
How issues and risks are registered and monitored.
How to use the hours entry module.

Progress: Planning
You are able to get an easy overview of the progress of the project on the project dashboard. Immediately
visible are:
· delayed and finished products
· the number of issues, risks etc. within your project and per product or work package.
· deliverables added to products, etc.
On the Gantt chart;

Planning on the Gantt chart

· If the final milestone of the product is delayed a red dot appears next to the product name.
· If milestones of the product have been finished, this is shown in the planning with a solid colour bar
inside the product bar.
· Finished products are marked with a tick (ü) and the solid bar indicates when the product actually has
been finished.
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To report progress you do the following:
1. Go to the ‘Project Dashboard’.
2. Click the name of the product to view the ‘Product page’.
3. To change the planned date, select the date and enter the new date in the calendar.
4. To register passing of milestones, tick the checkbox for Start/Draft/Checked/Final. The date will be set
to today by default, alternatively enter another date in the column 'actual date'.

Planning on the product page

5. Passing a milestone can also be marked directly on the project dashboard. To do this click the
appropriate milestone date next to the product and tick it off using the tick sign.
5.2.4.2

Registration of actual hours
Registration of hours in the Principal Toolbox can be done in multiple ways, depending on the available
add-ons:
· With time entry is available check 'Time Entry 133 ' for more information about possible configurations.
· Without time entry refer to 'Order Administration 131 ' to manually register actual hours.

5.2.4.3

Reporting
Within the Principal Toolbox you can make progress information available and generate reports. In this
section the various options will be presented.

5.2.4.3.1 Portfolio reporting (add-on)

Note: Portfolio reporting is only available when the Portfolio Management add-on has been installed.
If and when the project manager is expected to report project status information back to the Portfolio, a
reporting request will be sent and appear on the project.
The request is found within the project on a separate tab with name "Portfolio Report". The report
layout is based on the reporting model as defined on the portfolio.
To supply the requested information the project manager follows these steps:
1. Within the project, select the tab "Portfolio Report" and press the "Edit" button
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The portfolio report is to be filled out by the project manager

2. Update the editable fields with the latest information.
3. Update financial information (if requested).
4. Then press the "Publish to Portfolio" button to send the information off to the portfolio.
5.2.4.3.2 Copying data

Within the Principal Toolbox there are two options to copy a specific view to another application. Options
are:
- Copy to clipboard.
- Save list to RTF.
- Save list as XLS.

Copy to clipboard
The ‘Copy to clipboard’ function is a quick way to export the information shown on the current page to
another application (e.g. email).

Principal Toolbox 8.0
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button.

2. Then open the file you want to paste the information into. Choose Paste and arrange the document
composition yourself.
Note: The 'Copy to clipboard' function only work s in Internet Explorer, not in FireFox or Chrome.
For these browsers, use the RTF or XLS function instead.
Note: Some applications empty the clipboard when they are started. In that case, first open the
application and only then copy the information.

Save list as RTF
The 'Save this list as RTF' function creates a so called RTF (rich text format) file which can be opened in
MS Word.

1. Click the

button.

2. The web browser opens a pop up for opening or saving the RTF list.

Note: This is the Internet Explorer behaviour. For other browsers the downloaded file may appear
differently.
3. When clicking the 'Open' button, MS Word will automatically be opened and the data is available for
further modification.

Save list as XLS
The 'Save this list as XLS' function creates a so called XLS file which can be opened in MS Excel.

4. Click the

button.

5. The web browser opens a pop up for opening or saving the Excel list.
6. When clicking the 'Open' button, MS Excel will automatically be opened and the data is available for
further modification.
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5.2.4.3.3 Generating automated reports

The Principal Toolbox has extensive report functionality available. These reports come either as RTF-files
(readable by all text processors, like Word) and Microsoft Excel files.
Within the Principal Toolbox a number of fixed keywords are available which you can use in your
templates. When generating a report these keywords will be replaced by information from the Principal
Toolbox database.
All views defined in the Principal Toolbox (general and personal) are available for reporting.
1. Go to the ‘Project Dashboard’ or go to a specific product page where a merge template is available.

On the Project Dashboard

On the product page

2. To generate a report with the project actuals, click the name of the report at the heading ‘Automated
Reports’ or at the product page.
3. After the report is opened in a new screen it can be altered and then saved. In order to make the report
available to the project team it is necessary to upload it in the Principal Toolbox (see the next
section, Adding documents 104 ).

See Automated reports

174

for more information
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Document management and approval
You can store documents at various locations within the Principal Toolbox. The Principal Toolbox will
keep the documents in the database, so it will be available to all users with access to the documents in
the Principal Toolbox. It is possible to overwrite older versions with newer ones. The Principal Toolbox will
keep the old versions in storage. These will remain available for the manager of the particular level in the
tool.
On top of that, it is possible to put an approval cycle on deliverables and/or documents with the add-on
‘Advanced Customisation & Workflow’.
To make document management much easier, the tab 'Documents' has been added on the project level.
This tab makes it easier to search for specific documents within a project. The tab gives you several
options to search for documents.

5.2.4.4.1 Adding documents and templates to products

Documents in any file type can be added to a 'Product page’:
Product Description
Templates
Deliverables

:
:
:

Product specification; goal, composition and quality demands.
Template(s) as the basis for the (management) products.
Products/documents to be delivered.

1. Go to the ‘Product page’.
2. Click Add in order to add a document or to add an intranet link. Fill in the following information:
Description
: Description of the document.
Revision/Doc nr.
: Document version.
Filename
: Select a document with the ‘Browse’ button or, alternatively
Internet address
: Fill in a hyperlink.
Internal document link : Provide a document ID from a document at another location in the Principal
Toolbox application. The ID can be found in the document history.
This allows for a centrally placed document to be linked to from projects.
Update by updating only the original centrally placed document.
3. Click OK to add a document to the Principal Toolbox.
Note: As of release 6.5, document can be dragged and dropped to any document list. For steps 2
and 3 the document is simply dragged with your mouse from your local computer and dropped on
the listing. Description and Revision/Doc nr. will not be set automatically but can be set afterwards
using the 'update' function.
You are able to open documents saved in the Principal Toolbox, however you are not allowed to edit
them. In order to edit a document it is necessary to download the document. After editing you have to
add it as a new version.
Note: Hyperlink s have the following syntax:
· internet addresses look lik e "http://intranet.organisation.com/documents/example.doc"
· link s to document locations look lik e: "file://p:\documents\example.doc"
When using link s to document locations, mak e sure all users have the same drive mapping.
5.2.4.4.2 Updating a document

1. Locate the document you want to update.
2. To update the document with a new version, select it and click Update. Fill in the following
information:
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Filename
Internet address
Internal document link
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: Standard description of the last version
: New version number.
: Select the new version of the document with the ‘Browse’ button,
: OR fill in a hyperlink.
: Provide a document ID from a document at another location in the
Principal Toolbox application. The ID can be found in the document
history.
This allows for a centrally placed document to be linked to from
projects. Update by updating only the original centrally placed
document.

3. Select the document concerned and click Show History in order to show a list of all the former
versions of the document. Remove other versions by using the ‘Remove’ button.
5.2.4.4.3 Document approval (add-on)

Important documents like the Project Initiation Document (PID) and end project report need to be
approved by a member of the project board. Other documents/deliverables in the project may need to be
approved by a specific person as well. To support this approval procedure, the ‘Approval’ add-on is
available.
1. Go to the 'product page' of a product.
2. Click

+ or + note at Deliverables to insert a specific deliverable.

3. To request approval on this document, place the tick mark in front of the document and click the
‘Request Approval’ button. A new window will open.
4. First you will have to define the approver(s) for the document. The next step is to set the due date and
insert any remarks to inform the approver(s). If you do not want to send an e-mail to the approver,
remove the tick mark at ‘Notify Approvers’.
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Requesting approval

5. Click OK to sent the document in for approval. On the product page the status changes to 'Waiting for
approval’.
Approving a document
The reviewer needs to review the document and approve or disapprove it. The documents which need to
be approved can be found at the reviewers ‘Home' page.
1. Go to your ‘Home' page. Here you will see all documents waiting for approval.

2. Click the Product name to open the specific ‘Product page’. To review the document click the
document name.
3. After the review you need to ‘Approve’ or ‘Reject’ the document by clicking the appropriate button
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. A new window will appear where you can insert remarks.

4. Click ‘OK’ to finish the approval procedure. And the status of the document will change to Approved or
Rejected.
5.2.4.4.4 Adding minutes of meetings

Fast consultation of the minutes of meetings can be very useful for the project team members and
makes the dissemination of minutes and diary dates unnecessary.
In the logs section on your project dashboard you find a link for ‘Minutes of meetings’. Here you can
keep all of the meeting reports and appropriate documents.
1. Go to the ‘Project dashboard’
2. Select ‘Minutes of meetings’ under the logs.

Logs

3. Using ‘+’ you can add the minutes of the meeting, with ‘+ note’ you can add a note and with remove
you can remove it again.
4. Using the ‘History’ and ‘Update’ buttons you can look at the history of a document and with update
you can replace an existing document (see Updating a document 104 ).
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Minutes of meetings

5.2.4.5

Issues, risks, quality reviews and lessons learned
Within the Principal Toolbox all (possible) log items (issues, risks, quality reviews, changes, lessons
learned) can be logged through the different logs available on the project dashboard.
On all logs custom fields can be defined with the add-on ‘Custom fields’ 220 . Only the basic functionality
is explained in the manual. The logs available within the Principal Toolbox, are
· Issue log 109
· Risk log 110
· Quality review log 111
· Change log 113
· Daily / Action log 114
· Lessons learned log 115
Note: An issue, risk etc. can initially be created on project level, but after examination can be
reassigned to a specific product or work pack age. To assign an issue, risk , etc. to a product (or
to change the product which is affected) open the issue and select the appropriate product in the
pull-down menu at 'Product'.
Note: The owner of a log item are able to change all information of that log item. The project
manager and project support can change all information of all log items at any time.
Note: As of release 7.0, it is possible to define a custom page layout on all log items. Such a
page layout is defined in the project model.

Adding an issue

History log
For every log-item there is a history tab available. This shows history information for tracking who has
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done what.

History tab for an issue

Discussion messages on log items
On a log item it is possible to add discussion messages. On these messages the author and date is
registered.

Here you are able to start a new discussion

5.2.4.5.1 Issue log

Issues can be created in two ways; by clicking ‘Issue log’ on the ‘Project dashboard’ or by making a
new issue from a product on the product page. In the second case the issue will automatically be related
to the specific product.
1. Go to the summary page of a product.
2. Now click the tab ’Logs’.
3. Click ‘+’ in the blue ‘Issue listing’ bar. Then fill in the following information:

Description
Type
Status
Priority
Due date
Decision
Owner
Product

:
:
:
:
:
:
:
:

Remarks

:

Give a description of the issue.
Choose the type; RFC, Off-spec, Question, Concern or Issue.
Give the status of the issue.
Decide the priority of the issue.
When does the issue need to be resolved?
The decision concerning the issue.
Owner/responsible person for the issue.
To which product or work package is the issue related, leave blank when it
is project related.
Any remarks concerning the issue.

4. By clicking ‘+’ or ‘+ note’ you can add important documents/notes on to the issue.
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Adding a new issue

5. You can always alter the issue later by clicking on the issue in the 'Issue log'.
6. The project manager and project support roles can also copy and move issues. To copy an issue to
another folder or project, you can use the 'Copy' and 'Move' buttons:
. With copy,
you create a duplicate issue within your own project. With the move button, you can select another
project or folder to move the risk to.

7. In order to close an issue you can set the ‘Status’ to ‘Closed’ but you can also select the log item(s)
by clicking the row to select and then clicking the 'ü' button.
Note: All project team members are allowed to create new issues. The project manager and
project support can edit all issues. The owner and creator of an issue can edit all information of
that particular issue.
5.2.4.5.2 Risk log

The risk log is a central place where risks are identified, described and where certain decisions and
actions are taken.
A risk can be made in two ways; by clicking ‘Risk log’ on the ‘Project dashboard’ or by making a new
risk at a product on the ‘Product page’. In the second case the risk is automatically related to the
specific product.
1. Go to the ‘Product page’ of a product.
2. Now click the tab ’Logs’.
3. Click here behind ‘Risk listing’ on ‘+’. Then fill in the following information:
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Due date
Decision
Chance
Severity
Owner
Creator
Product
Remarks
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Give a description of the risk.
Fill in the type of risk.
Fill in the risk status.
Decide the risk priority.
Final date where after risk measures need to be taken.
The decision of the risk occurring.
Chance of the risk occurring.
Impact cause upon risk occurrence.
Owner/responsible person for the risk.
Author of the risk.
To which product is the risk related, leave blank when it is project related.
Any remarks concerning the issue.

4. Save your new entry by clicking the 'Save' button.
5. Furthermore you can also add an action to the risk by clicking ‘+’ behind ‘Risk listing.
6. By clicking ‘+’ or ‘+ note’ you can add important documents/notes to the risk.
7. You can change the risk any time at a later date by clicking it's description in the ‘Risk log’.
8. Close a risk by setting the status to 'Closed'
9. The project manager and project support roles can also copy and move risks. To copy a risk to
another folder or project, you can use the 'Copy' and 'Move' buttons:
. With copy,
you create a duplicate risk within your own project. With the move button, you can select another
project or folder to move the risk to.

Note: Only the project manager and project support can create new risk s. However, the owner and
reviewer of a product can also create risk s related to that product. The project manager and
project support can edit all risk s. The owner and creator of a risk can edit all information of that
particular risk .
5.2.4.5.3 Quality review log

A quality review (quality control) is a standard method to test a product for its measurable quality criteria.
This technique is especially suitable for documents (e.g. developments, procedures and reports).
The criteria for the quality of a product are taken up in a product description. It describes the goal of the
product, the composition of the product, which sources are to be used, the form in which the product
should be delivered and which quality criteria the product must meet.
We will describe the quality review procedure underneath:
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1. Go to the ‘Product page’ of a product. The ‘checked’ date on this page gives the date on which the
quality review should be finished. To document this further, quality reviews can be created in the
quality review log.
2. Click the ’Logs’ tab.
3. Click ‘+’ in the blue "Quality review listing" bar.

4. Fill in the following information:
Description
Status
Priority
Due date
Method
Reviewer
Results
Owner
Creator
Created
Product

:
:
:
:
:
:
:
:
:
:
:

Remarks

:

Short description of the quality review.
Open/Closed. Has the review been carried out?
Priority of the quality review.
When is the review due by.
Describe the method (see the Product Description).
Who will carry out the review.
Give the review results. (--, OK and action items)
Owner of the quality review.
Creator of the quality review.
Date when the quality review was made.
To which product is the review related, leave blank when it is project
related.
Remarks with regard to the quality review.

5. Click the 'Save' button to save your new entry.
6. It is possible to add actions and documents to the quality review. To add an action you need to do the
following; click ‘+’ behind ‘Action listing’ and fill in the following information:
Name
Description
Status
Priority
Due date
Owner
Creator
Related to
Remarks

:
:
:
:
:
:
:
:
:

Name (identifier) of the action
Description of the action
Status (open / closed)
Priority
When should the action be finished
Owner / person responsible for the action
Who has created the action
Here a link to the quality review will be shown.
Any remarks, status description.

7. Click the 'Save' button to save your new entry.
8. By clicking ‘+’ or ‘+ note’ behind documents you can add documents or notes with additional
information to the quality review.
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Adding a quality review

9. To copy or move a Quality review to another folder or project, you can use the 'Copy' or 'Move'
button:

.

5.2.4.5.4 Change log

The Principal Toolbox has a separate ‘Change log’, which offers a central repository for documentation of
changes within your project.
The project manager needs to judge all issues by their priority and their impact. In case that an issue
(off-spec, RFC) falls within the tolerance of a stage then he/she can choose to accept the issue and log
the change in the ‘Change log’.
If an issue leads to the result that the project/stage is threatened to fall outside the tolerances set the
project manager needs to discuss the issue with the project board. They decide whether actions on the
issue are carried out or not. If the project board decides to accept the issue then the project manager
needs to define a change.
1. Go to the ‘Project dashboard’.
2. Go to the ‘Change log’.
3. Click '+' in the blue ‘Change listing’ bar.
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4. Fill in the following information:
Description
Type
Status
Priority
Due date
Owner
Creator
Created
Product
Remarks

:
:
:
:
:
:
:
:
:
:

Description of the change.
Choose between Specification, Hours, Costs and Planning
Open / closed
Low, normal, high, critical
Optional, final date the change needs to be dealt with.
Responsible owner of the change
Creator of the change.
Date of creation
Optional: product the change is related to.
Any remarks / status description.

5. Save the new entry by clicking the 'Save' button.
6. If necessary, it is possible to add a related action to the change. Click ‘+’ in the blue 'Action listing'
header on the details page of the change. For more info about actions see Daily/action log 114 .
7. By clicking ‘+’ or ‘+ note’ in the 'Documents' header you can add any related documents or notes.
8. To copy or move a change to another folder or project, you can use the 'Copy' or 'Move' button:
.
9. To close the change, set the status of the change to 'closed'. Alternatively, from the change log, you
can select the change and set the status to closed with the ü button.
5.2.4.5.5 Daily/action log

Actions can be created from product pages, related to issues, risks, changes, quality reviews and from
the action log.
To define an action do the following:
1. There are several places from where you can create actions, if you have the correct user rights:
a. From the project dashboard, open the 'Daily/action log'.
b. Alternatively, go the 'Logs' tab of a product.
c. Find the blue 'Action listing' header when on the detail page of an issue, risk, or other log item.
2. Now click Action log and fill in the following information:
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Name of the action.
Description of the action.
Status (Open/Closed).
Priority.
When does the action need to be completed.
Owner/responsible for the product.
Creator of the action.
Relation to a product, issue, risk, etc.
Any remarks

Adding an action

3. Click the 'Save' button to save your new action.
Note: Only the project manager and project support can create new actions. However, the owner
and reviewer of a product can also create actions related to that product. The project manager and
project support can edit all actions. The owner and creator of an action can edit all information of
that particular action
5.2.4.5.6 Lessons learned

To archive positive or negative experiences that may be useful in future projects the lessons learned log
is available. Based on the lessons learned log you can create an automated 'lessons learned report' at
the end of the project. The lessons learned can be from all areas of interest; the project management
method, tools used, good/bad experience with suppliers, etc.
The report can published to allow the organisation to improve the best practices from among other things
its project management. Add valuable lessons learned to the project model(s) to have them easily
available for project managers and team members.
1. Go to the ‘Project dashboard’
2. Now click the ’Lessons learned log’.
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Lessons learned log

3. Create a new lessons learned entry by clicking '+'.
4. Fill in the following information:
Name
: Name of the lesson learned
Creator
: The creator is filled in by the tool.
Created
: Creation date of the lesson learned. Filled automatically.
Remarks
: Explanation of the lesson learned.
5. If more information needs to be added to the lesson learned, a document or note can be attached.
Click ‘+’ or ‘+ note’ in the blue 'Documents' header to add a document or note.
6. After completion of these actions, click the 'Save' button to save the new entry.
7. To copy or move a lessons learned to another folder or project, you can use the 'Copy' or 'Move'
button:

.

Note: Only the project manager and project support can create new actions. However, the owner
and reviewer of a product can also create actions related to that product. The project manager and
project support can edit all actions. The owner and creator of an action can edit all information of
that particular action.
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Finishing a project
Once the products of the project have been realised the project needs to be finished in a controlled way.
A number of management products such as the lessons learned report, end project report, and a followon action recommendation can be used to report about open actions and recommendations. The project
board will then confirm the project closure.
The lessons learned report can be based on the lessons learned log that has been kept during the
project. It is quite easy to generate an automated report 174 of this log.
The other logs can be consulted to make the end project report and the recommendations for follow up
actions. In the recommendations for follow on actions all the points of attention are shown that are no
longer carried out in the project but can be dealt in a new project.
In this section we will further review:
- archiving projects; 117
- removing a project or project model.

118

The activities described in this section can only be carried out by the folder manager.
5.2.5.1

Archiving a project (-model)
Note: Archiving a project can be done by the manager of a folder / project list, or the system
administrator. Archived projects are no longer visible to users without these roles. If you want the
project to remain available, create a separate project list called 'Archived projects', or a similar
name.
After the project has been finished and the project organisation has been disbanded the project can be
archived.

Archive

1. Go to the ‘folder dashboard'.
2. Select the project concerned by clicking on it's row.

3. Click

to move the selected project(s) to the archive tab.

4. In a pop-up window, you are asked to confirm archiving the selected project (-model). After clicking OK
the project (-model) is move to the archive.
5. The archive can be found at the tab 'Archive' on the folder / project list level. Note that each folder or
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project list has its own archive.
6. Restoring a project or project model can be done from the 'Archive' tab.
5.2.5.2

Removing projects and project models
Removing projects and project models requires two steps; first you need to archive the project (model)
and thereafter you can remove the project (model) from the archive. How to archive a project (model), see
chapter Archiving a project (-model) 117 .
1. After archiving a project (model), go to archived project (model) by clicking the 'Archive' tab.

Archive tab

2. Select the project (model) concerned by clicking it's row.

3. Click ‘

’ behind the project (model) and confirm with ‘OK’.

Remember: Once projects or project models have been removed from Principal Toolbox it is not
possible to roll back this decision.

5.3

Classic PRINCE2 Project
As of release 6.0 a new project model has been made available which replaces the Classic PRINCE 2
Project model. The new project model, called Generic PRINCE2 Planning Model, offers new
functionalities for the Gantt. To be able to use the new Generic PRINCE2 Planning Model, you will have
to import the new project model first.
Starting up a new project with the Classic PRINCE2 Planning Model:
1. Go to the Portfolio dashboard and click on + in the ‘Project listing’.
2. Enter the details and select the classic project model.
3. Select a project manager and click on OK to create the project.
The project is now available on the folder and/or portfolio dashboard. The project manager is now able to
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start planning his or her project.
Generic information about planning and managing a project is provided as part of the Generic project
planning 78 .

5.3.1

Planning a Project
Each product in the project has four milestones you can use to manage product delivery.
· Start:
set the date work has to start on the product
· Draft:
plan the delivery of a draft version
· Checked:
set the end date for quality review
· Final:
the planned date for delivery of the final version of the product.
Planning the milestones within the project can be done in two ways:
On the dashboard and plan tab :

Set milestones individually on the project dashboard or ‘Plan’ tab.

119

On the Gantt chart

120

:

Use the Gantt chart editor with ‘drag & drop’ functionality.

The option with dashboard and plan tab is more or less like working like an Excel sheet, using a table to
fill out dates for your project. The Gantt chart option provides a graphical planning chart, which you can
edit using ‘drag & drop‘ functionality. We will explain the two options in the next two paragraphs.
5.3.1.1

Using the dashboard or plan tab
On the project dashboard and the 'Plan' tab, dates can be set by use of the keyboard and by selecting
them in a calendar with your mouse.

Filling in the milestones on the 'plan' tab.

1. Go to the project dashboard or the 'Plan' tab.
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2. Click
3. Fill in the milestones for each products:
o Start:
set the date work has to start on the product
o Draft:
plan the delivery of a draft version
o Checked: set the end date for quality review
o Final:
the planned date for delivery of the final version of the product.
The use of these milestones is optional. Principal Toolbox uses start and end dates to calculate
duration of the project, stages and work packages. Therefore it is recommended to use at least
these milestones on each product.
3. Dates are changed by clicking the double dashes, or by clicking an already present planned
milestone. Enter the date with your keyboard, or select the date in the calendar.
Note: If a milestone has finished (depicted by:' ü ), you cannot change the date directly anymore.
To change milestone data then, click the product name to open the product detail window. On the
'general' tab, you can delete or change the actual dates for each milestone.
5.3.1.2

Using the Gantt editor
A Gantt chart shows a timeline of your product with the product milestones. Because Gantt charts are
simple to understand and easy to construct, they are often used by project managers.
To use the Gantt chart in your project, follow these steps.
1. From inside your project, click the Gantt tab. A Gantt chart will be shown with all stages, work
packages, and products listed. When you haven't entered any planned dates (milestones) yet, the
start date of the project will be set to the date of today and the duration of all products will be set
according to the duration in the project model.

Gantt

2. To edit the Gantt chart, click

in the blue page header.

Note: Only products can be planned directly in Principal Toolbox. Stages and work pack ages are
summaries of the products they contain, so these cannot be changed directly.
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Note: To select products in the edit Gantt window, click the product name on the left of the
window. To select multiple products, k eep CTRL or SHIFT pressed while click ing multiple
products.
3. On the next page the planning can be entered in two ways. In the left hand half you can enter dates by
clicking the cells and using the calendars. Alternatively, you can use the graphical part of the window.
Here, you can change duration and dates with your mouse by dragging the time lines of products.

4. First of all you need to define the start date of your project. To do so click
. In the dialogue,
select the start date. This can also be used to move a group of products to a specific start date. See
the note above for info about selecting multiple products.
5. Set the date of the first product in every stage or work package by dragging this to the planned start
date or use the button shown above. All products in this specific work package or stage will be moved
automatically to this date.
6. The next step is to plan the products in this specific stage or work package individually:
a. To move the product forwards or backwards in time you need to place the cursor in the centre of the
product bar, hold the left mouse button down and drag it to the correct position.
b. To alter the duration, you need to place the cursor on one of the sides of the product time-bar and
drag the side in the desired direction.
7. To define the draft and checked milestones or to set dates in a calendar, you can use the left side of
the ‘Edit Gantt’ window. After clicking in a cell, a pop-up shows a calendar where you can choose the
date.
As soon as you have set the draft or checked milestones in the table on the left, they are shown in the
timeline on the right. Now you can drag them with your mouse as well.

Editing the Gantt

8. To define dependencies between products, select two products and click Add dependency. This will
create a finish-to-start dependency between the two products. To edit dependencies see the section
defining dependencies 96 . To delete a dependency use Remove dependency. Buttons:
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9. If dependency conflicts exist in your planning you can use the 'Solve conflicts button':
the products you want to be recalculated and click the button.

Before: dependency conflict

. Select

After: problem solved

10.When the plan is finished, click the ‘Save’ button to save the changes made.
11.As of version 7.5 it is possible to highlight the critical path. To do this click 'Edit', next click 'View'
and select 'Show critical path'.
Note: inconsistencies or conflicts resulting from mutually depending products are indicated by
coloured indicators. For their meaning, consult the use of colours in projects 80 . For more help on
dependencies, see defining dependencies 96 .

5.3.2

Planning products
In the Principal Toolbox, product based planning takes a central place. Budgeting and cost registration is
also product based, so all costs are calculated towards products.
Note: time, stage or project based costing is also possible in Principal Toolbox. In this case,
dummy (management) products are added to the project plan (see planning resources 163 ). In the
case of time or project based costing, add the dummy products to the last stage of your project.
This way, they stay visible throughout the project.
For the registration of both costs and hours, five types of registration are available:
· Budget
: The approved budget
· Committed : Costs you will have to pay, e.g. a contract signed, but not yet invoiced
· Actual
: Money or hours actually spent
· Remaining : An estimate of costs or hours necessary to complete the product.
· Variance
: The variance relative to the budget.
Formula: variance = budget - EAC

Below you'll find the steps to set the budget for your project.
1. Go to the 'Plan' tab.
2. In the pull down menu select Costs manual or hours manual.

3. Click
and fill in the budget in the field 'Hours budget manual’ (hours) and ‘Cost budget manual’
(costs). Fill in ‘Hours remaining manual’ and ‘Cost remaining manual’ with the same value of hours and
costs. By doing this you keep the ‘variance’ with respect to the budget, at the start of the project at 0.
As the project progresses you can see at ‘variance’ the number of hours or costs over or under the
budget.
4. Alternatively, go to the each product page and click the tab Costs & Hours and insert the different
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budgets there.

Costs & Hours on a project level

Costs & Hours on a product level

Using description above gives an overview of your project costs and hours in tabular form. If you want to
keep track of history or the construction of the numbers on the page, the Principal Toolbox has the
option of cost and hour entries. If these are available within your organisation, you will find a section
'costs / hours listing' on each product page, on the 'Cost & Hours' tab, as shown below.

5.3.3

Assigning responsibilities for products
Next step is to assign the responsible owners to the products in your project. This can be done by either
the project manager or project support roles. Before you can assign products to project members, you
have to make sure that all required resources are a member of your project (management) team.
Note: You will first need to assemble your team. You can do this here

89

.
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Assign products to owners, reviewers and participants
1. Go to the ‘Plan’ tab.
2. Complete following information for each product:
Owner
Reviewer
Participants

: Owner/responsible for the product.
: Reviewer of the product.
: Participants at the product realisation.

Plan tab

By clicking on Edit and then clicking on the double dash a menu appears and you
can select resources or dates. Selected resources and dates can be changed later
in the same way.
The menu which assigns participants to a product also works in another way
whereby more people can be added.
3. Select one or more members from the column on the right with your left
mouse button (to select multiple members at the same time, keep the CTRL
key pressed) and click the ‘<’ key.
4. Click ‘OK’ to assign the participants to the product. You can remove members by selecting them from
the left hand row and then clicking the ‘>’ key.

5.4

Agile Project Management (add-on)
As of release 7.0 a new project model has been made available. The new project model, called the Agile
Project Management Model, offers new functionality to support Agile project management and SCRUM
teams. To be able to use the new model, you will have to purchase and import the new project model
first. You can purchase the Agile Project Management Model from our Sales Office.
Starting up a new project with the Agile Project Management Model:
1. Go to the Portfolio dashboard and click on + in the ‘Project listing’.
2. Enter the details and select the new project model.
3. Select a project manager and click on OK to create the project.
The project is now available on the folder and/or portfolio dashboard. The project manager is now able to
start planning his or her project.
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Generic information about planning and managing a project is provided as part of the classic project
planning 118 and the generic project planning 78 (introduced in release 6.0).

5.4.1

Agile Project
The classic PRINCE2 project allows for a strict planning according to the PRINCE2 project management
methodology. It does not allow for activity planning, only stages, work packages and products are
supported.
The next sections provide information on using the agile project:
- Agile project dashboard 125
- Planning an agile project 126

5.4.1.1

Agile Project Dashboard
The agile project dashboard is one of the most important windows, because it enables the project
manager to monitor the progress of the project.

Agile project dashboard

1.

Tabs
The tabs are standard for each project. Depending on your organisation's license some tabs might
not be available. The name of the tab indicates the content of the page:
- Properties

:

- Task board
- Planning

:
:

- Resource Management (add- :
on)

- Documents

:

- Reports

:

Includes all project properties including custom fields and portfolio
information.
An overview of all the tasks and user stories per sprint.
Contains the backlog, Gantt chart and a summary of the Costs
and Resources.
When the Resource Allocation add-on is available, the Resource
Management Coordinator is able to request resources within the
organisation units. It also gives the Resource Management
Coordinator an overview of the requested and allocated resources.
To manage project related documents the Project Manager can
use the tab ' Documents'. This tab makes it easier to search for
specific documents within a project. The tab gives you several
options to search for documents.
Report functionality about the products, cost / hour entries and
resource assignments of the project.
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2.

Logs
It gives an overview of the logs 108 that are used in an Agile environment (most correspond with the
logs that are used in a PRINCE2™ environment). A counter is displayed for each log indicating the
number of items there are for each log and if there are new items. The log is selected by clicking the
name of the log.

3.

Burn-down chart widget
One of the available widgets for Agile projects. The burn-down chart widget can be used to track the
completed user stories and the remaining story points of the sprint.

4.

Agile PM - Explanatory Notes
Here you see an explanation about working with the Agile PM. Note that this is a realisation of the
Image & Text widget.

5.

Product list
Here you find the plan item planning concerned with the various stages and sprints.

Planning an agile project
Project planning within the Principal Toolbox can be done by following these four steps:
1.
2.

Defining a product backlog & starting a sprint.
Assign tasks on the task board. 127

126

This sequence is just a suggestion. An iterative planning process is always possible; editing your project
plan and other data remains possible throughout your project.
5.4.1.2.1 Defining a product backlog & starting a sprint

To work with the Agile PM the product backlog has to be defined. To do this navigate to the 'Planning'
tab and click the 'edit' button.

The product backlog of an Agile project.

The product owner can now enter all backlog items and assign owners to the user stories.
The available items in the backlog are:
- Epic
- User story
- Bug
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During sprints completed items van be set to 'done' using the percentages column.
When the product backlog has been filled the first sprint can be started.
To do this navigate to the 'Planning' tab, sub tab 'Gantt'.
Click the 'Edit' button and pick user stories from the backlog for the current sprint.

Agile Project Gantt and Sprint planning.

While working with the Agile PM there are some essentials to note.
- The throughput time of user stories can be set independently from the duration of the sprints. Sprints
are not as long as the combination of user stories (which is the case with PRINCE2TM projects).
- Details such as Story points, Priority and Streams can be assigned either by clicking on the User
Story in the Gantt chart or by clicking on the user story names on the task board.
5.4.1.2.2 Assigning tasks on the task board

Assigning task on the task board is done in the Gannt chart.
Go to the 'Planning' tab, sub tab 'Gantt'.
For the current sprint, assign the user stories to employees.
The tasks on the task board are now assigned.
Notice that:
- When task are dragged around and dropped on the task board, the burn-down chart is affected
directly.
- The story points at every stage is calculated in the header (Between brackets).
Next, navigate to the tab 'Task board' and drag the task into the appropriate columns.
The columns are:
1. Other:
2. To do:
here.
3. In Progress:
4. Review:
reviewed.
5. Testing:
6. Rejected:

All (currently) unplanned tasks can be dropped here.
Tasks that should be completed during the coming sprint should be dropped
When an employee starts working on a task, the task should be dropped here.
After completing a user story the task should be dropped here to state that it should be
When the task is ready for testing it should be dropped here.
When a task gets rejected this is the place to drop it.
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When the task has reached the state of 'Done' it should be dropped here.

The Agile task board with all tasks.
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Managing project models
In the Principal Toolbox, all projects that are created are based on a project model. A project model is an
extensive template for projects. It contains products, templates added to these products, lessons
learned, and automated reports. This way, it is possible to have standardised projects throughout the
organisation, and project managers always have the right templates available. Right from the moment a
project is created, automated reports (if available in the project model) are available for reporting
purposes. Below, an example of the dashboard of a project model is shown.

Part of the dashboard of the PRINCE2 project model. The dashboard of a project model is identical to a project
dashboard.

It is possible to have multiple project models within your organisation. For instance, a default PRINCE2
project model for general use and more specialised project models with specialised content. For
instance, a project model for sales or one for software implementation. For these purposes, you could
build a product breakdown (see the section about product breakdown 84 ) that matches most situations
for these specialised projects.
In the next sections, you will find information about
· Editing project models 129
· Creating project models 130
How to create automated reports is explained in the automated reports
See also working with models

5.5.1

35

174

section.

for more information.

Editing project models
Note: Project models can be edited by the manager of the project model, or by the system
administrator.
Project models can be edited in the same way projects are edited in Principal Toolbox. So, it is possible
to add templates, documents, automated reports, a product breakdown, issues, risks, lessons learned,
etcetera.
Any data you enter into the project model, except for user names (owners of issues, products, etc.) are
copied into projects created with that project model.
To prevent your original project model from being polluted, or your templates etc. from being lost, it is
recommended to work with a temporary project when you want to create or change a project model. This
way, you can enter example data to check views and automated reports, without affecting the original
project model. Take the following steps:
1. Navigate to a folder / project list where you can create a temporary project. If there is no such folder or
project list, create it or discuss it with the system administrator.

Principal Toolbox 8.0

Project Managem ent

130

2. Create the temporary project, based on the project model that best approaches your desired end
result.
3. Change the project to match your desired model.
a. Optionally, add a product breakdown for projects with similar end results.
b. Add the default management products that are used in your organisation. Use the blue products for
management products.
c. Add green project board products to mark decision points, go / no go decisions in your projects.
d. Set up stages, work packages and add the appropriate (management) products to the stages and
work packages.
e. Set mandatory items in the planning.
f. From the project dashboard, add templates to products.
g. Add automated reports 174 to your project dashboard.
h. Configure custom page layouts for the project properties and/or product / plan items.
4. When finished editing the project, navigate back to the folder / project list dashboard. Create the
project model as described in the next section 130 .
5. After finishing the project model, archive and then remove the temporary project.
Notes:
· All operational data in your project will be discarded when creating a project model. So
milestone dates, deliverables, issues, risks, changes, quality reviews, cost and hour data will
be removed.
· Any data in the project model itself will be copied into the project when you create a project
based on that project model, except for any user names in your project.
· After creating a project, there is no link whatsoever between the project model and the project.
So if you change any document templates, or automated reports in the project model, this will
not affect the project.

5.5.2

Creating project models
New project models are always based on existing projects. A system administrator or folder / project list
manager can create project models from any project. First select a project by clicking in the row of the
project concerned. Use the 'Model' button available at the folder / project list dashboard, as illustrated
below.

folder Dashboard

In the dialogue, give an appropriate name to the project model. After choosing OK, the project model will
appear on the dashboard of the folder or project list underneath the 'Project model listing' header at the
bottom of the page.

5.5.3

Enterprise models
Project models can be created in any project list or folder. The model will be available on the level of the
containing folder / project list and on all sub-levels. To make a project model available throughout the
Principal Toolbox you can publish it at the so-called enterprise level (the highest level) in the Principal
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Toolbox.
Two options are available to get the project model at the highest level.
First option
1. The 'new project model' option.
a. Go to the highest level of Principal Toolbox (enterprise level). Open the tab Models.
b. Click New at project model listing.
c. In the dialogue, define the name and description for the project model.
In the lower part of the window, select the folder where the project model is located. Then select the
project model you want to promote to enterprise model.
d. Click OK and the model is added to the list of enterprise project models. The model is now available
within all folders of Principal Toolbox and can be chosen when creating a new project anywhere.
Second option
2. With the export / import option.
a. First export the project model you want to publish. The model will now be saved as a file. Save it at
an appropriate location.
b. Then navigate to the highest level of Principal Toolbox (enterprise level). Open the tab Models.
c. Click Import. Choose the project model file and fill in the other fields in the dialogue.
d. Click OK and the model is imported into the list of enterprise project models. The model is now
available within all folders of Principal Toolbox and can be chosen when creating a new project
anywhere.

Enterprise models

5.6

Order administration
As of release 7.5 order administration has been made available. Order administration enables users
capture orders and commitments within the Principal Toolbox. Orders can be linked to plan items. It is
also possible to link multiple orders to a single plan item. Orders provide direct insight in current and
planned expenditures based on planned hours.
To start using order administration the Project Model needs to be reconfigured first:

1. Navigate to the appropriate project model and click
model.

to reconfigure the project
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2. Set the costs that should be editable within order administration to editable, for 'Costs are entered
on' select 'Orders in the order log and the financial forecast grid on the portfolio reporting tab'

The order administration configuration of the project model.

After configuring the project model navigate to the project where order administration should be applied.

1. Click

to create a new order.
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2. Enter a description and select an owner.
3. By clicking on the description further detail can be configured.

4. Click

to start editing the order.

5. On the 'Properties' tab a Product / Plan item can be linked to the order.
6. A Financial Category has to be assigned for every order. This remains editable and can thus be
changed when desired.
7. To edit the financials, click the appropriate field in the 'Financial' section. A special editor opens. This
editor states on what dates certain amounts of costs should be processed.
In the example below on march 26th 2015 100.00 euros and 200.00 euros will be processed.
Committed and Actual costs can be entered using the same process as well.

Entering costs on orders.

6

Time Entry (add-on)
As of release 8.0 of the Principal Toolbox, organisational units have been introduced. This introduction
has had a significant impact on the processes of Time Entry and Resource Allocation, now combined into
Resource Management.
When your current version is prior to release 8.0 the functionalities of these
modules can be found in the old version of the manual. As a result of this there is no longer the need to
configure time entry groups since the organisational unit for which you activate the Time Entry Module
acts as such.
Registration of hours using the Principal Toolbox is done by using the module 'Time Entry'. Users of the
Principal Toolbox who are assigned to organisational units with Resource Management enabled will
receive a time sheet which they can then use to register the hours worked against projects and nonproject activities, like leave. Using these time sheets, actual cost entries can be allocated against
projects and non-project activities according to pre-defined hourly rates.
Before starting it is important to navigate to the appropriate organisational unit and activate Time Entry for
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this organisational unit.
Note: In versions prior to 8.0 it was necessary to define time entry groups for time entry, these are
replaced by organisational units. The organisational unit for which time entry is activated is your time
entry group. For more information see the Organisational Units 14 section of the manual.

6.1

Generating, submitting and approving time sheets
The process contains the following steps, which are explained in the next sections.
1. Creating a time entry configuration 134
With this step, you define which products are shown on users' time sheets, and whether or not they
have a free choice of products on their time sheet. Different configurations can be used for different
organisational units.
2. Creating non-project activity sets 217
These sets can be used to define activities that are not part of projects. These could be operational
duties, and non-productive hours, lik e sick leave, holidays, leave. For different organisational units,
different sets can be created.
See also Registration of actual hours

6.1.1

100

for more information about using Time sheets.

Creating a time entry configuration
The time entry configuration defines a number of options for the way time sheets are provided/managed.
The main configuration concerns the available products or plan items that are shown/selectable on the
time sheet.
Two methods exist depending on the setting at Settings > Configuration > Time Entry > Settings >
Support for Activity Planning.
If set to ' No', the configuration provides following options:
· which products are shown/selectable on time sheets:
· "membership" based: only products of which the user is owner, reviewer or participant are
shown on the time sheet, regardless of budget.
· budget based: only products that have a budget assigned are shown, but then to all
members of a project.
· whether only products from active stages are shown, or all products from the project
· whether users are allowed to choose products of projects they are not a member of.
If set to 'Yes', the configuration provides following options:
· which filters should be used for pre-selected items
· which filters should be used for selectable items
Creating a time entry configuration (Support for Activity Planning = No)
Another way to create a time entry configuration is by using so-called 'Planning Item Filters'. These
configuration options are bit more flexible and offer more filter options.
1. To enable the 'Planning Item Filters' navigate to Setup > Configuration > Time Entry > Settings.
2. Click on Edit to disable the 'Support for Activity Planning'.
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Enable Support for Activity Planning

3. Go to Manage Time Entry Configurations module.

4. Click on

to create a new time entry configuration.
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Time Entry Configuration with planning item filters

5. Fill in the following information:
Name
Description
Product membership
Product budget
Allow free entry

:
:
:
:
:

Name of the time entry configuration.
Description of the time entry configuration.
Select which products will be automatically available for time entry.
Select which products will be automatically available for time entry.
Select if users may select products free.

6. Show fields on Time Sheet
Show fields on time sheet

: · Product field (read-only): select which
information about the product will be
displayed on the time sheet (i.e. the
number of risks, the number of issues,
etc.)
· Entry Field (selectable in time sheet):
select on which entry field data can be
entered in the time sheet.
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7. Approval
Approval

: · Select the option 'Auto Approve on
Submit' if the Department Manager
doesn't need to approve the hours. For
more information about the approval
process please take a look at:
Configuring the approval process 140 .
· Create draft entries on request approval:
use this option if a draft entry needs to
be created when requesting approval.

8. Click Save to store the time registration configuration.
9. Now you can close this dialog, by clicking Close.

Time entry configuration with product / plan item filters (Support for Activity Planning = Yes)
There are multiple ways to create time entry configuration. The default way to define a time entry
configuration is described below.
1. Navigate to the Settings > Configuration > Manage Time Entry Configurations.

Overview of the available Time Entry Configurations.

2. Click

to add a Time Entry Configuration.
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Creating a Time Entry Configuration.

3. Enter the following information:
Name
Description
Split Up Time Sheets on Month Transition
Create new Time Sheets after Approval Request
Allow external users as time entry group members

4. Set the pre-selected Planning Item Filters.

: Name of the time entry configuration.
: Description of the time entry configuration.
: Select whether the time sheets are to be
split on month transition.
: Select whether new Time Sheets are to be
generated after the Approval Request.
: Select whether external user as time entry
group members so that Time Sheets are
generated for them as well.
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Pre-selected Planning Item Filters

: Select which products will be automatically
available for time entry. Every option
contains filters that will determine which
products will be displayed on the time
sheet. The following options are available:
· Show all products by default.
· Only show the products with a budget
(With budget).
· Only show the products with a budget
and in progress (With budget and in
progress).
· Only show the products with an owner
assigned (With ownership).
· Only show the products with an owner
assigned and in progress (With
ownership and in progress)
· Show all products/activities with the field
'Pre-selected on Time sheets' selected
on the product page. By selecting this
field on all products it is possible to
determine per product wether it should
appear on the time sheet.

5. Set the selectable Planning Items.
Selectable Planning Items

: Select which products can be selected on
the time sheet by the users. The same
options are available as described above.

6. Select which fields should be shown on the Time Sheets.
Show fields on time sheet

: · Product field (read-only): select which
information about the product will be
displayed on the time sheet (i.e. the
number of risks, the number of issues,
etc.)
· Entry Field (selectable in time sheet):
select on which entry field data can be
entered in the time sheet.

7. Select the approval options. For more information of Time Sheet approval click here
Approval

8. Click Save to store the time registration configuration.
9. Now you can close this dialog, by clicking Close.

148

.

: · Select the option 'Auto Approve on
Submit' if the Department Manager
doesn't need to approve the hours. For
more information about the approval
process please take a look at:
Configuring the approval process 140 .
· Create draft entries on request approval:
use this option if a draft entry needs to
be created when requesting approval.
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Creating Planning Item Filters
It is also possible to create your own 'Planning Item Filter'. By creating you own filters you can determine
which type of products should be pre-selected or selectable.
1. Click in the Time Entry Configuration on the tab Planning Item Filters
2. To create your own 'Planning Item Filter' click on View and select Set Filter.

Creating a Planning Item Filter

3. A list with available filters will appear. Configure the filter and click on OK.
4. To save the view click on View Options and Save View.
5. Enter the name of the view, select the type and click on OK.
6. The 'Planning Item Filter' is now available in the time entry configuration.
6.1.1.1

Configuring the approval process
Approving Time sheets can be set up in four different ways:
· Approval required by the project manager and line manager:
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· Approval required by the line manager only

· Approval required by the project manager only

· No approval required: Time sheets are automatically approved when submitted

The approval process can be configured in these various ways using a number of settings. The steps to
configure each approval process follow below.
Approval by project manager only
1. Navigate to Setup, Configuration, Time Entry, Settings, and set the setting 'Allow project
manager to approve hours' to 'Yes'.
2. Open one of the project models and on the dashboard press 'Edit Properties'.
3. Within the section 'Time Entry' tick the box for 'Approval of project hours by project manager'.
4. The project manager will now be able to approve hours by project. To do so, the project manager
opens a project, navigates to the Resource Management tab, and opens the 'Approve Hours' screen.
The project manager will get an overview of all the hours that have been submitted against the project
and which require approval.
A similar overview, but then across all projects, can be found on the project manager's dashboard on
the tab 'Approve Hours'.

Approval by line manager only
In case a line manager needs to be able to approve Time sheets, the line manager needs to be made an
Approver on one or more Time Registration Groups.
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1. Open a Time Entry Configuration from within Configuration > Manage Time Entry
Configurations.
2. Make sure that Auto Approve on Submit is unchecked.
3. Open the Resource Management Configuration at the appropriate organisational unit.
4. Select the configuration that you have just edited and select the appropriate approvers in the Resource
Management Configuration.

Automatic approval
Enabling Auto Approve on Submit will remove the need for line manager to approve Time sheets. This
setting is changes as follows:
1. Open a Time Entry Configuration from within Configuration > Manage Time Entry
Configurations.
2. Make sure that Auto Approve on Submit is checked.
3. Open the Resource Management Configuration at the appropriate organisational unit.

Configuring the right approval process
With the above knowledge in mind, the approval process can now be configured as required.
Approval by project manager and line manager
1. Enable the option to have project managers approve hours (see above for instructions)
2. Set the line manager up to approve hours (on the Organisational Unit -> Resource Management)
3. Check that the applicable Time Entry Configuration is not set up for Auto Approve

Approval by line manager only
1. Set the line manager up to approve hours (on the Time Registration Group)
2. Check that project managers are not allowed to approve hours (see above for instructions)
3. Check that the applicable Time Entry Configuration is not set up for Auto Approve

Approval by project manager only
1. Enable the option to have project manager approve hours (see above for instructions)
2. Enable the Auto Approve on the applicable Time Entry Configuration (this will ensure that line
managers are skipped)

Automatic approval
1. Enable the Auto Approve on the applicable Time Entry Configuration
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2. Check that project manager are not allowed to approve hours (see above for instructions)

6.1.2

Entering & Submitting time sheets
Any Time sheets that need filling out will appear on the personal dashboard of the employee on the tab
'My Time Sheets'.

My open Time sheets on the homepage

Entering time sheets
By clicking the date of the time sheet, the time sheet opens. On it you will find the selection of products
you are allowed to book hours on. The selection of products that is shown is dependent on the settings
of your 'time entry group'. It could be, that only products are shown of which you are owner, reviewer or
participant. Alternatively, only products with an hours budget can be shown on time sheets.
In both cases, you can add the number of hours in the row of the appropriate product, in the column of
the correct day. The total number of hours for each product, day, and week is shown directly on screen.
At the bottom of your time sheet, you find a selector for projects and non-project activities. Here you can
select products or activities that are not shown in the product list.
After finishing your time sheet, you need to request approval on the data you entered. How this works is
described in the next section 148 .

Time sheets
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Principle of time sheets and hour entries
Time sheets need to be approved, otherwise the hours and associated costs will not be accepted. After
approval of the time sheet, the fields of the time sheet will be added to the appropriate products in the
form of a so called cost/hour entry. These entries are visible to the project manager from the product
detail page. They provide an overview of the different bookings that have been made on products and
allow to see which user worked how many hours on what date on which product.
Mobile Time Entry
Note: The manual contains screenshot tak en from the application on a tablet. When accessing the
application on a phone the screens will split.
When you log in to the app and navigate to the time sheet section you can see all your open time
sheets.

The open time sheet for the current user.

You can update the time sheet by selecting the day and activity.
You are then able to register your hours and add a comment.

Principal Toolbox 8.0

Tim e Entry (add-on)

Time registration by Rob.

These hours are automatically updated in the Principal Toolbox and the application.
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Update hours in the time sheet.

By clicking 'Submit' the time sheet will be submitted for review and can no longer be edited.

146

Principal Toolbox 8.0

Tim e Entry (add-on)

147

Submitting the time sheet.

Submitting time sheets
Any open time sheet will be displayed as a listing. Click on the start date of the time sheet to open it.
The following window will open:
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A time sheet

When finished entering hours, press 'Save' or 'Save and Request Approval'. The latter option will only
be available when an approval process has been set up.
After requesting approval, the project manager and / or the line manager will get the request for approval
on their personal dashboard as a reminder. Please see 'Approving Time sheets' 148 for instructions on
how to approve the submitted Time sheets.

6.1.3

Approving time sheets
Approval by project manager
When a time sheet has been submitted and it contains hours against the project manager's project, and
the hours require approval, they'll appear on the project manager's personal dashboard. The tab
'Approve Hours' will show a list of all hours that require approval.

Approving hours

Approval by line manager
When a line manager has been registered as an approver on one or more time entry groups, a list of the
submitted Time sheets will appear on the line manager's personal dashboard.
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By clicking on the start date of one of the Time sheets it opens and the line manager, after reviewing the
contents, can choose to Approve or Reject the request for approval.

6.2

Time and cost allocations
Against products, part of a project, cost and hour entries can automatically be generated from the Time
sheets that have been submitted. The tab 'Costs & Hours' on each product will then list all the costs and
hours in line with the Time sheets from project team members that registered hours against the project.
The costs associated with the hours that the team member registered are based on an hourly rate. Each
resource has its own hourly rate, as defined in the Setup. Besides this personal hourly rate, the project
manager can be allowed to override that rate for a project specific rate.
To enable the automatic generation of cost and hour entries based on time entry, take the following
steps.
1. Define and allocate hourly rates

149

2. Let project managers set hourly rates

150

3. Get cost and hour entries against individual products

6.2.1

152

Defining and allocating hourly rates
Defining hourly rates
Before assigning hourly rates to individual resources, define the rates as follows:
1. Navigate to Setup, Configuration and click on 'Manage Hour Rates'
2. Click '+' to add a new hourly rate
3. In the window that appears, choose a name, a description, a code (free text), and the hourly rate in
dollars (or applicable currency).

New hour rate
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4. Once saved, the hourly rate will be available to be assigned to resources.

Allocating hourly rates
1. From within Configuration navigate to 'Manage Resources'
2. Edit one of the resources by clicking on its first name
3. The window that appears allows to set one specific hourly rate for this resource.

Managing resources

6.2.1.1

Letting project managers choose hourly rates
It's possible to let the project manager choose hourly rates for the resources on a project. This feature
has to be enabled in the Setup and on the project model.
Setup
1. From within Configuration click on Time Entry.
2. Open the Settings, and enable the setting 'Allow project manager(s) to configure hour rates per
resource'.
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Allow project manager(s) to configure hour rates per resource

Project Model
1. Open one of the project models
2. At the project model's dashboard press 'Configuration
3. Enable the setting 'Configuration of hour rates per resource by project manager'.

Edit properties on projects

After this setting has been enabled, the project manager can alter the hourly rate for the resources on
the project. This is achieved as follows:
1. From the project dashboard, click on the tab 'Resource Management' and choose for 'Resource
Rates'
2. Press the 'Edit' button and set the required hourly rate for each resource on the project.
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Assigning project specific resource rates

6.2.2

Time and cost allocations against products
After setting the appropriate hourly rate, each time a time sheet has been approved hour entries will be
allocated against the appropriate products. Costs will be associated with the hours based on the
applicable hourly rate: either the resource's rate, or if set, the rate as defined by the project manager.
The generated hour and cost entries are listed on the 'Costs & Hours' tab on each product.

Cost & hours tab on products

7

Resource Allocation (add-on)
As of release 8.0 of the Principal Toolbox, organisational units have been introduced. This introduction
has had a significant impact on the processes of Time Entry and Resource Management (previously
Resource Allocation), if your current version is prior to release 8.0 the functionalities of these modules
can be found in the old version of the manual. As a result of this there is no longer the need to configure
resource pools since the organisational unit for which you activate the Time Entry Module acts as such.
Resource Allocation supports the process of planning and managing resources on projects. The process
can be carried out in different ways:
· Resources are requested at project level
· Resources are requested at product level
· Or a hybrid option: both at product and project level
Two roles are associated with this process:
-

The project manager can request resources to staff his or her project. Resources can be
requested as skill, or, if the project manager has a specific preference, as ‘named’ resources.

-

The resource management coordinator (or ‘resource coordinator’ for short) is the coordinator
of one or more organisational units. As such, the resource manager registers resources, resource
availability and resource skills. Furthermore, the resource manager manages resource requests from
project managers by allocating resources to specific projects.

How to set up the resources, skills and the availability of the resources, is explained below.
Note: A user can be given resource manager rights in Principal Toolbox by an administrator. To
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do so, navigate to the appropriate organisational unit's dashboard and click on Edit Roles.

Edit members for Resource Allocation

Before starting it is important to navigate to the appropriate organisational unit and activate Resource
Allocation for this organisational unit.
Note: In versions prior to 8.0 it was necessary to define resource pools for time entry, these are replaced
by organisational units. The organisational unit for which resource allocation is activated is your resource
pool. For more information see the Organisational Units 14 section of the manual.

7.1

Managing resources
Pending resource allocation requests are managed by a resource allocation manager.
1.

Navigate to the Resource Management tab of the organisational unit that you would like edit.

2.

Navigate to the “Resource Allocation” tab. In the “Request & Allocation” section, a grid is shown with
requested, allocated, remaining and available hours per period for each resource.
The cell3s in this grid are colour coded to provide a quick overview:
·

Blue cells indicate resource requests that are not yet (fully) fulfilled with allocated
resources.

·

Green cells indicate remaining hours that can be allocated to projects or nonproject related activities.

·

Red cells indicate over-allocation of a resource in a specific period.
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Overview of the entire resource pool

Note: The columns with planned, requested, and allocated hours can be toggled on and off by
check ing or uncheck ing the check boxes directly underneath the header of the Request &
Allocation section.
Note: If needed, the timeline setting of the grid can be edited. To do so, click on Edit Timeline
Settings. Set the horizon and start date according to your preferences.

3.

Click Edit in the header of the “Request and Allocation” section to change allocation details of
resources to various projects.
Click on the ‘+’-sign in front of a project to expand that project and look at the details per resource.
Alternatively, click on the ‘+’-sign in front of the top row “[All resource]” to view all resources in the
resource pool without sections per project.

4.

To allocate a resource, or change an existing allocation, edit the values in the “Allocated” columns
for each resource per period.
Note: In case of a requested sk ill instead of a specific ‘named’ resource, first select the resource
with the requested sk ill as primary or secondary sk ill that you want to allocate before entering the
allocated hours.

5.

7.1.1

Click Save to save your changes. This will automatically send new or changed allocation details to
the appropriate Project Managers.

Adding skills & resources
Before you are able to request and allocate resources you will have to define one or resources. To do
this, you will have to define skills and then appoint these skills to resources. After you have done that,
you can add resources.

Adding, removing and editing skills
In order to be able to define resources and their skills, a set of skills needs to be defined first. Skills have
to be defined only once and can be used for multiple resources. This allows you to report on skills over
multiple resources.
1. Navigate to the Setup and Configuration in the dark blue header on the top of the screen.
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2. On the left-hand side of the screen you'll find many options including 'Manage Skills'.

Manage Skills at Setup

3. To add a new skill: Click
new skill can be specified)

to add a skill (a popup window will appear in which the name of the

4. To remove previously defined skills: Select a skill (or select multiple skills by using the ‘Control’-key)
and click Remove.
5. To edit previously defined skills: Click on the name of the skill to be edited (a popup window with the
skill details opens). Click Edit to edit the skill name.

Adding a skill

Adding new resources in Principal Toolbox
Before resources can be appointed, resources and their skills need to be defined in the Principal
Toolbox. Users are automatically available as resources, additional resources can be defined by a
resource manager as follows.
1. Navigate to Setup and Configuration in the dark blue header on the top of the screen. The left-hand
side of the screen contains a link to 'Manage resources'.
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Manage Resources at Setup

2. The screen contains two sections: one for 'no users' and one for 'users'. Click
in the 'no users'
section to set up a resource which is not is associated with an user account in the Principal Toolbox.

Creating a new resource (no user)

3. A new window will appear. Enter the details of the new resource and click Save. The new resource
will be listed in the section 'Resources (no users)'.

Appointing primary and secondary skills to resources
1. To appoint primary skills to resources (both users and non-users) click on Edit. Select the desired
primary skill and click on Save. (Alternatively, to edit both primary and secondary skills of a resource,
follow the steps below.)
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2. To appoint (a) secondary skill(s) to resources (both users and non-users), click on the name of the
resource you want to appoint skills to (a new window will appear in which the resource details are
listed)

Appointing a secondary skill

3. Click Edit to modify the resource details, including the primary and secondary skills.
4. Click Save to save the modifications, and click Close to return to the main window.
7.1.1.1

Non-project activities
To allow for allocation of a resource to non-project activities (and thus diminishing the resource’s
available hours for project allocation), one or more sets of non-project activities need to be defined.
1.

Navigate to the Resource Management Tab in the appropriate organisational unit.

2.

Click Resource Management Configuration to select the appropriate Non-project activity set.
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Select a non-project activity set

3.

Click OK to return to the main window.

Creating non-project activity sets 217 is part of the 'Configuration'. For more information click on
System Administrator: Setup & Settings 214

7.1.2

Managing resource availability
The resource availability can be managed by the resource manager.
1.

To edit availability of resources in an organisational unit, navigate to the Resource Management
tab of the appropriate organisational unit.

2.

Click on the tab “Availability (Resources)”. A grid with the allocated hours, remaining hours and
available hours is shown.

Adding the resource availability

Note: The columns with allocated, remaining and available hours can be toggled on and off by
check ing or uncheck ing the check boxes directly underneath the header of the resource
availability section.
Note: If needed, the timeline setting of the availability grid can be edited. To do so, click on Edit
Timeline Settings. Set the horizon and start date according to your preferences. It is also
possible to set the scale and unit.

3.

Click
in the title bar of the Resource Availability Section. In the table in the Resource
Availability section, the available hours can be entered for each resource in the columns “Available”
per period. Only specify the hours that each resource is available to be allocated to projects
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Adding non-project activities

4.

To allocate a resource to non-project activities:
a.

Add a new row for the resource that needs to be assigned to non-project activities

b.
c.

by clicking on the
sign in front of the resource’s name. A new row appears
with a blank activity field.
Click on the blank activity field and select the right non-project activity.
The hours to be allocated to the selected non-project activity can be entered in the
columns “Allocated” per period.
Repeat steps 5a through 5c for each additional non-project activity.

d.
5.

7.1.3

Click Save to save your changes.

Managing requests and allocations
A Resource Coordinator is responsible for evaluating all resource requests that are coming in, and
turning them into allocations.

1. Open the 'Request & Allocation (Projects)' tab in the appropriate organisational unit (Resource
Management tab).
It will display a planning board with requested and/or planned, allocated and remaining hours for each
resource.
Note: depending on the chosen resource allocation process, the button 'Edit Timeline Settings' allows
for changing whether planned and/or requested hours are being displayed. To mak e the change, set
the 'Resource Allocation Process' to one of 'Project request driven', 'Project demand driven', or
'Hybrid'.
The individual cells in the planning board are colour coded to give an immediate impression:
- Blue: shows all requests for resources which haven't been (completely) satisfied by resource
allocations
- Green: depict remaining hours available to be allocated against projects and non-project
activities
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- Red: alarm the resource manager to the fact that resources have been allocated over and
above their availability

The planning board is used to manage the requests for resources

Note: the columns with requested, allocated, remaining and available hours can each be hidden by
toggling the check boxes
Note: using the button 'Edit timeline settings', the period covered by the planning board, and its
resolution can be changed
2. Press the 'Edit' button in the 'Request and Allocation per Project' section of the screen to edit the
allocation of resources.
Use the
to check the details per individual resource on a project. By expanding the 'Resources
Summary' it'll show the total allocation per resource independent of the projects.
3. To change the allocation of a resource, fill out the values in the Allocation column. This can be done
for each separate period. The period is determined by the timeline settings.
Note: when a sk ill has been requested, instead of a specific named resource, the resource manager
will have to select a named resource with the specified sk ill before allocating hours.
4. Press 'Save' to keep all changes. The allocations are published to the projects and are now available
to the project managers.
Note: with the '<', '>' and '>>' it is possible to move all editable values one week to the left (<), one
week to the right (>) or four week s to the right (>>) .

Principal Toolbox 8.0

Resource Allocation (add-on)

161

Move editable values

Discussions between project manager and resource manager
Using the Principal Toolbox it's possible to discuss requests and allocations between project manager
and resource manager. The discussion is initiated by the resource manager and works like a chat
service. It's used as follows:
1. From the resource allocation module, open a resource pool and navigate to the 'Request &
Allocation' tab.
2. Press the Edit button of the planning board.
3. Press the Pencil icon next to the project for which a discussion is to be started

Opening a discussion log

4. A chat session is opened in which the resource manager can enter a message for the project
manager.
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Discussion log

5. After pressing 'OK' a message will be sent to the project manager.
6. The project manager receives the message in the Resource Allocation tab on the project. A
response can be given by clicking 'Edit' and sending it by using the Envelope button.

Discussion log on projects

7.2

Managing resources on projects
Using the Principal Toolbox resources can be requested to work on projects. Requests can be submitted
for the project as a whole or by individual product. When done by individual product it's called a 'demand'
rather than a 'request'. Depending on the organization's requirements one of these planning processes
can be chosen, or a hybrid model can be used.

7.2.1

Requesting resources
1. In an organisational unit or project, navigate to the “Resource Management” tab, section “Resource
Allocation”. In the “Request & Allocation” section, a grid is shown with planned, requested, and
allocated hours. Blue cells indicate resource requests that are not yet (fully) fulfilled with allocated
resources by the Resource Coordinator.
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Note: The columns with planned, requested, and allocated hours can be toggled on and off by
check ing or uncheck ing the check boxes directly underneath the header of the Request &
Allocation section.
Note: If needed, the timeline setting of the grid can be edited. To do so, click on Edit Timeline
Settings. Set the horizon and start date according to your preferences. It is also possible to set
the scale and unit.
2.

To assign one or more resources to the project (only needs to be done once for every project, or
whenever changes are required), click Edit Resources on the Resource Management dashboard. A
popup window will appear in which one or more available resources can be assigned to the project.

3.

In the header of the “Request & Allocation” section, click Edit to start requesting resources for the
project.

Requesting resources on a project

4.

To add a row in which a resource or skill request can be entered, click on the
in front of the
appropriate resource pool. To request a resource, perform one of the following steps:
a.

b.

To request a specific ‘named’ resource, select a resource name from the drop down
menu in the resource name field underneath the appropriate resource pool.
Optionally, select the skill that the resource is requested for in the drop down menu
in the skill field next to the resource name field.
To request a skill instead of a specific resource, select a skill name from the drop
down menu in the skill field. The resource coordinator will allocate a resource with
the desired skill to match the request.

5. Click Save to save your changes. This will automatically send new or changed requests to the
Resource Coordinator.

7.2.2

Planning resources
Note: The new generic project planning
there 82 .

78

provides a different approach, please refer to the help
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Instead of, or complimentary to requesting resources at project level, resources can be 'planned' at
product level. To do so, follow these steps:
1. Open one of the products on the project and navigate to the tab 'Resource Demand'.
2. Within the section 'Resource Demand' press the Edit button.
3. Using the planning board, resources can be planned by Skill, named Resource, or both.
4. Additionally the hourly rate can be chosen as it may be specific to the project.
Note: as soon as a resource registers hours against a project, using the time entry module, the
default hourly rate as defined for the resource will be used. If this default rate is different from the rate
as chosen when demanding resources, the project manager will have to explicitly change the rate that
is used when the resource enters time against the project. Please see 'Letting project managers
choose hourly rate' 150 for instructions on how to set the appropriate rate.

Resource planning on product level

An overview of all planned resources on the project is found on the 'Resource Allocation' tab, under the
header 'Resource Management'. To only view planned resources (and not the requests) the timeline
settings have to be changed. Press the 'Edit Timeline Settings' button to set the Resource Allocation
Process to 'Project Demand Driven'.
Any hours planned against the product will be evenly distributed across the duration of the product,
which is defined by its start and end dates.

8

Reporting
Reports can be used in projects to provide reports about your projects, folder, portfolio's, time entry
groups etc.
· General reporting 165 is provided throughout the application and is based on the ability to create views
on all kinds of data.
· When working with hours and costs, it is also possible to create timeline reports 170 that provide
options to report data in respect to the book date of the hours and costs.
· Based on these reports (general and/or timeline), automated reports 174 can be created that combine

Principal Toolbox 8.0

Reporting

165

information from different views into a single report or apply specific formatting.
· Finally, the Principal Toolbox allows for reporting using widgets 188 , dynamic functionality provided on
dashboards that show the data in a specific way.

8.1

Reports
Throughout the Principal Toolbox, reporting is provided on the data that is available at various locations.
Note: Timeline reports provide a special way of reporting over costs and hours, see timeline
reports 170 .

Basic project report

Reports provide different views that each set specific filtering, column (or field) selection and other
options to tune the data that is shown.
Option
Set filter

Remarks
The set filter options allows to select fields available for the object that is being
reported.
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Columns can be selected and ordered to build the views content. Next to selecting
columns for the view, the sorting and the number of results shown per page can be set.

Principal Toolbox 8.0

Reporting

167

Set widths

Width of the columns in the view can be controlled by dragging the column separator
to the desired position.

Chart options*

The chart options allow to show the results of the view in a chart (like bar, line or pie
chart) instead of a plain table.
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Finally, some special options can be set like hiding a header caption, provide a total
etc.

Once views are configured, the views can be saved for re-use later or for the creation of automated
reports.
Save view

168

Saves the current configuration of the view. The view can be saved as a new view or
overwrite an existing one.

Principal Toolbox 8.0

Reporting

169

Views can be set to one of the following types:
Personal The view is available to the current user only but can be used throughout
the application (for the same type of object). This option is available to all
users.
Local
The view is available to the current location only but can be used by
everyone (that has access to the location). This option is available to users
with manager/coordinator permission on the location.
Global
The view is available for all users at all locations (for the same type of
object). This option is available to administrators only.
Make default

Sets the current selected view as default (for the current user only!). Default views are
indicated by an asterisk (*) behind the name of the view in the view selector.

Manage views

To manage all views that have been created at a specific location (or for a specific user
etc.), the views can be managed to remove, rename or alter the global view parameters
(like type or hidden).

Views are shown in respect to their type: personal, local, global or built-in (provided by
the application).
Views can be exported or imported from other applications as well to re-use
configurations, e.g. from a test environment.
If the user has sufficient permissions, views can be modified by clicking the name and
clicking 'Edit':
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* Will be deprecated in release 7.0

The data that is shown can be exported to Word, Excel or the clipboard for use later on. Finally, views as
saved on these locations can be used to create automated reports 174 .

8.2

Timeline reports
A timeline is a graphical representation of information in relation to time. Timeline reports enable you to
instantly report on different types of cost or hour entries over time. Timeline reports can be used to
compare your available resource capacity with you requested and allocated resource availability. It can
also be used to compare the budget and actual costs within a project.
Timeline reports work like pivot-table known from MS Excel. It creates reports on entries coming from
time registration, cost entries and resource management.

Example: Timeline Report

Based on the start and end date of an entry a timeline report creates an overview in time, for instance the
total costs per month per project or the number of hours resources are allocated to projects.
The timeline reports can be found on the same location as the normal reports. So they are available
enterprise-, folder-, portfolio- and project level. They are also available in the different modules like time
registration and resource management.
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Two representation types are available:
table
chart
Timeline report views can be used in automated Excel and Word reports.

Example: Timeline Report Chart

171
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Example: Timeline Report Table

The different options in the View options menu are:
Basic Setting
Set filters
Set widths

Make default
Save view
Manage views

: To configure the timeline report view
: Define a filter to make a selection of
the shown items
: Set the column width, so the view fits
better on screen or in a MS Word
report. Drag the line between columns
to increase or decrease the column
size.
: This sets a view to the personal default
: Save the view for later use.
: Set properties for the view. You find
more information at 'Manage views 30 '.

Create a Timeline report view
This example describes how to create a table with costs per product per month for this year within a
project represented as a timeline report.
Basic Settings
1. Navigate to your project in Principal Toolbox and go to the ‘Report’ tab
2.

Click on ‘entries’ in the Timeline report - section

3.

Open ‘view options’ and choose ‘Basic Settings’

4.

Set the values for the settings
a. unit : select ‘Money (changes on book date)’. This setting is used to select which kind of entries
(costs or hours) you want to see and in which unit it is represented on screen. The system
automatically calculates the data between different unit settings.
b.

Scale: set scale to weeks to show the costs per week.

c.

Start date: set a dynamic or fixed start date where the windows of the timeline must start.
Select ‘This year’ as a dynamic start date.

d.

Horizon: set the number of weeks, months or quarters to show starting at the start date.
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5.

Apply a filter on entries: select ‘Budget’ and ‘Actual’ in the filter type. This will give you only the
cost-entries of the type budget and actual.

6.

Select ‘Table’ as the representation type to get a table with the budget and actual costs

7.

Table configuration – select the field to show per row. Select product and type to display the product
name in the type of entry (budget or actual).

8.

Click ‘OK’ and see the result on screen
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Save view
If you want to save the newly defined view you need to save it with Save view. To overwrite an existing
view you saved before, select the name of this view at the Existing view pull down list. To create a new
view, enter the new name at 'New view'. Click Save to save the view.

Save view

Select personal, local or global. See manage views

30

for more information.

- With the ‘Make default’ option a specific view can be set to the personal default view on that page.
- With the button ‘Manage views’ the views available can be managed. See Managing views

8.3

30

.

Automated reports
Automated reports can be created in the Principal Toolbox and both in Word and in Excel. The Word
reports offer more possibilities for editing after generating the report, while the Excel reports offer more
flexibility in working with tables. It is also possible to use so-called ' Timeline reports' to show information
over time.
The automated report functionality of Principal Toolbox has especially been designed to allow you to
create and edit your own automated reports.
Note: Automated reports within projects are available to project managers and project support. On
folder level they are available to the folder manager.
Note: Normally, automated reports will be provided with the project model(s) of your organisation.
It is possible, however, to create your own reports for your folder, portfolio or project.
Principle of automated reports
Automated reports use keywords that are replaced with data from the Principal Toolbox database. This
can be either simple content of fields, like a project name and a start date, or complete tables. These
tables are the views (either pre- or self-defined) at various locations in Principal Toolbox.
The keywords, which include references to the views, can be found in the 'Keyword reference'. When
clicking a keyword, it is copied to the Windows clipboard. You can now paste the keyword in your report
template. After saving the template on your system, upload it to Principal Toolbox and the report is
available for use.
Note: Some applications empty the clipboard when they are started up. In this case, first open the
application and then click the k eyword.
Where to find and manage automated reports
Within projects:
On the project dashboard in the section 'Automated reports’ or at a specific product page.
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Click 'Edit' at automated reports to manage reports within a project or project model
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On product or plan item pages templates for automated reports can be added as well

Within folders (or project lists) and portfolio's:
On the dashboard, at the section 'Automated reports'.
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Automated Reports on a folder

In the next sections, you will find more detailed information about creating and managing automated
reports.

8.3.1

Automated Word reports
Note: Word reports are based on templates that have to be saved as Rich Text Format (*.rtf)
files.
1. Go to the dashboard and click the button ‘Edit’ in the Automated report header, or go to the specific
‘Product’ page where you want to insert the new automated merge report.

2. You can do any of the following:
a. Open one of the templates already present, by clicking . The template will be opened, and at the
same time Principal Toolbox will open a window with the 'Keyword Reference'.
b. Start with a 'normal' or new Word document. Click Keyword Reference to open the window
containing the keywords.
3. The Keyword Reference window will open where you can select the keywords. To select a keyword,

Principal Toolbox 8.0

Reporting

178

just click it.

Keyword list

5. Go back to your template in Word. Look up the position where you want to paste the keyword.
Pasting can be done in two ways:
a. By selecting Paste in the Edit menu
b. With the shortcut key CTRL+V.
6. Finish the automated merge report and save it as an RTF-file.
a. Choose Save As in the File menu
b. In the dialogue, choose an appropriate folder for your template.
c. At Save as type choose Rich Text Format (*.rtf)
d. Click Save to save the template

7. Go back to Principal Toolbox. To upload the merge template in the Principal Toolbox, click

in
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the Templates section (in the Edit Automated Reports window or on a product page). Fill in the
following information:
Description
Revision/Doc nr.
Filename
Internal document link

:
:
:
:

This will be the title of the report shown on the dashboard
Use this to give a version number to your template
Locate the RTF-file with the browse button
Provide a document ID from a document at another location in the
Principal Toolbox application. The ID can be found in the document
history.
This allows for a centrally placed document to be linked to from projects.
Update by updating only the original centrally placed document.

8. IMPORTANT: Make sure the checkbox 'Document is a merge template' is ticked!

Adding a Word file

9. Click ‘OK’ to add the merge template to the Principal Toolbox.
10.The document is now available as an Automated Report. If you added it to the section Automated
Reports on a folder / project list or project dashboard, you will find it in the list Automated Reports. If
you added it to a product page, it will appear in the list 'Templates' on the General tab.
11.To generate the Automated Report click the template name and it will open in a new window.
12.After the report is opened in a new window it can be altered and then saved. In order to make the
report available to the project team it is necessary to upload it in the Principal Toolbox.
Note: To edit the automated report or merge template later on, go back to step 2a and continue.
Note: In RTF templates the system setting (default or custom) is used for language, not the
personal locale.
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Automated Excel reports
The Microsoft Excel reporting allows you to create well formatted reports based on Principal Toolbox
data. The reports can be extended with charts.
An automated report for Excel must to contain macros to be able to retrieve data from Principal Toolbox.
Therefore, you need to be able to run macros to generate these reports. The Excel reports are based on
a special Principal Toolbox template. This template contains keyword that point to fields and views in
Principal Toolbox. When generating a report, these keywords are replaced by data from the Principal
Toolbox.
In this section, we will explain how to generate Excel reports. Creating and editing templates yourself is
possible, even with basic Excel knowledge Some of the more advanced features would require some
more knowledge of Excel. The topics can be found below:
· Using an Excel report 180
· Creating an Excel report template 181
Note: automated reports within projects are available to project managers and project support. On
folder level they are available to the folder manager, etc.. You will need sufficient rights on your
computer to run Excel macros.
Note: Excel reporting is intended for Office 2007+ as of release 6.5. For compatibility with Office
2003 an older version of the Excel template can still be used. Download the old template here and
add it manually to the desired location.

8.3.2.1

Using an Excel Report
To generate an Excel report, you can click the report name, on a folder / project list dashboard, or on the
project dashboard. In the example below, the available Excel report is shown and can be clicked by the
user.

Automated reports on the project dashboard

Note: Excel reporting is intended for Office 2007+ as of release 6.5. For compatibility with Office
2003 an older version of the Excel template can still be used (contact Fortes Solutions for more
information).
When the Excel report is downloaded, the following message is shown to you by your browser.
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In this dialog, click 'Save' and select an appropriate location for the template. Then click 'Open' to open
the report in Excel. Saving the report first ensures that the Excel file will be opened correctly. If opened
directly, the required support macro's included in the Excel file will not be started.
When opening the file in Excel, the data is automatically 'refreshed' with the currently available data.

Automated issue log in Excel

If you want to add the report as a deliverable in a project, add it as a deliverable. See section adding
documents to products 104 .
8.3.2.2

Creating an Excel Report Template
Creating an Excel report template is done by following these steps:
1.
2.
3.
4.

Download a basic Excel report template 181
Open the template and insert keywords 183
Extending the report data 186
Finish the template and make the report template available within the

187

Principal Toolbox

8.3.2.2.1 Open the basic Excel Report Template

Note: You need to be manager of the folder or project to create and edit report templates. Within
a project, also project support can do this.
To create an Excel report template, log in to the Principal Toolbox application and navigate to the 'level'
on which you want to place an Excel report. For example, when you want to create a project report,
navigate to the project. When a folder report needs to be created, navigate to a folder where you have
access to the automated reports.
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On the chosen level, click the Edit button to access the available automated reports. A page as shown
below should appear.

Automated reports page.

On this page, click the 'Download Basic Excel Template' button to download an empty template that
can be used as a start for creating the report template. Instead of starting a new template, an existing
template can be used to modify, if one is available. In this case, click the 'Open template' button on the
Excel template in the list.
Note: Excel reporting is intended for Office 2007+ as of release 6.5. For compatibility with Office
2003 an older version of the Excel template can still be used. Download the old template here and
add it manually to the desired location.
When the Excel template is downloaded, following message is prompted by the browser.

In this dialog, click 'Save' and select an appropriate location for the template. Then click 'Open' to start
configuring the template in Excel. Saving the template first ensures that the Excel file is opened
correctly. If opened directly, the required support macro's included in the Excel file will not be started.
On completion, you should have the Excel file opened on the work station as shown below. When
prompted whether to enable or disable macro's, click to enable macro's (as they are required to use the
template correctly).
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Empty Excel file

Note that you should now have a special ribbon (PTB):

Excel ribbon

The ribbon provides three sections:
· Reporting, provides options available to templates as well as generated reports like pivoting, charting
and PowerPoint presentation. generation.
· Template, provides functions applicable to building a template: opening available keywords, refresh
data, toggle visibility of keywords in the template and saving the template.
· General, configuration, help and an about dialog.
8.3.2.2.2 Inserting Principal Toolbox Keyw ords

Keywords are used to define which data will be imported from Principal Toolbox into your report. These
keywords are provided in a context-sensitive list, the keyword reference. This list can be opened from
within your Excel template. Click the 'Merge Keywords' button on the template toolbar to open a browser
window with the available keywords for this template.
A page like the one below should appear. Note that the content of the page may differ per project / folder.
Note: if the report is to be used on different locations within the application, mak e sure to only
use generally available k eywords. This is mainly the case with the availability of views.
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Keyword list

Click a keyword to copy the information to your clipboard. Then select the appropriate location in the
Excel template where you want to place the related data. To get the keyword in the template, choose
Paste in the Edit menu. Alternatively use the shortcut key CTRL+V.
For example, when clicking the 'name' keyword, the keyword can be inserted in the Excel file on
location B2. Note that when inserting the keyword, the keyword is replaced with the actual data
immediately. During this process, a dialog appears showing the progress of the operation.
Now, insert a view (table of date) in the template by selecting a keyword related to views. In the example
below, the view on open issues is inserted.
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Inserting a keyword

Again, the keyword is immediately replaced with the data. You are now able to change the format of the
table appropriately. E.g., make the column heading bold and have adapted width of the columns.

Formatting the table

In the example above, the table has been adjusted and additional information inserted (labels, report title
etc.). If necessary, the data can be refreshed by clicking the [Refresh PT Data] button on the template
toolbar.
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8.3.2.2.3 Extending the Report Data

Extending report data allows you to add information to the report data retrieved from the Principal
Toolbox. For instance, adding a calculated column to a table. This can be useful when data has to be
presented different than the default formatting or if the data needs to be post-processed.
The report extension is standard Excel functionality and can be applied as is on single cell data (like the
budget field of a project). However, for tables of data based on views in the Principal Toolbox, it is more
complex. The data coming from Principal Toolbox have a dynamic behaviour. The number of rows may
change in time and / or the location at which the report is used. This behaviour makes extending the
report data (and other advanced options) a bit complex as it has to be configured in such a manner that it
works independently from the number of rows in the table.
To start, it assumes that an appropriate view is created in the Principal Toolbox and is available as a
keyword for use in the Excel template. As a result, a template as shown below could be created.

Extending the report data

To add the calculated impact data, a column heading is added next to the 'Remarks' column. Also, in the
cell below this heading, the following formula is entered:
==IF([@[Due Date]]="";"";IF([@[Due Date]]<TODAY();TRUE;FALSE))
(adapt the formula as necessary to refer to the correct cells!)

This formula calculates the impact based on the values detected for 'Chance' and 'Severity'. Next, extend
the formula to be applied to all rows and the first empty row below the table of data. See the picture
below.
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Report data extended

The row below the data is considered to be a 'store' of the formulas and formatting to be applied to the
table. When refreshing the data, the formula(s) in the first empty row below the table of data will be used
for all rows (independent of whether there are more or less rows of data).

8.3.2.2.4 Finishing the Excel Report Template

When all the keywords have been inserted into the template and required charts and Pivot tables have
been added, the template can be made available within the Principal Toolbox.
To publish the template for use of reporting, navigate to the appropriate location in Principal Toolbox. For
example, if you would like to use the report on a folder, navigate to that specific folder dashboard to add
the template.
Tip: If you add the template in a model (either a project model or an MSP folder model), the report
becomes available automatically on the projects / MSP folders that are created based on the
model.
At the appropriate location, access the automated report list ([Edit] button on the list of available
automated reports). See also creating an Excel report template 181 .

To upload the merge template in the Principal Toolbox, click
Automated Reports window). Fill in the following information:

in the Templates header (in the Edit
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This will be the title of the report shown on the dashboard
Use this to give a version number to your template
Locate the XLS-file with the browse button
Provide a document ID from a document at another location in the
Principal Toolbox application. The ID can be found in the document
history.
This allows for a centrally placed document to be linked to from
projects. Update by updating only the original centrally placed
document.

IMPORTANT: Make sure the checkbox 'Document is a merge template' is ticked!

Adding a Excel Report Template

Click ‘OK’ to add the merge template to the Principal Toolbox. The document has now been made
available as an Automated Report and it can be found on the dashboard in the list Automated Reports.
To generate the Automated Report click the template name and it will open in a new window. After
completion, the template can be used as a report within the project / folder etc. See using the Excel
report 180 .

8.4

Widgets
Widgets can present data directly, without having to run a report or opening a view. Widgets are easy to
configure and refresh the data automatically. Widgets can be used for reports, but can also support
specific processes and can be developed specifically for customers.

Widgets on a portfolio dashboard
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Widgets are available on several places in the Principal Toolbox. They will not be displayed
automatically.
Enable widgets:
1. Click on Edit Widgets to make widgets available on your screen.
2. Use the ‘ü’ to display the widgets.
3. Select the number of widgets that should be displayed.
4. Select the type and confirm with Ok.

Edit the widget lay-out

Widgets will now be displayed on the page. Once displayed, almost all widgets have three common
buttons:
Allows to configure the widget. Configuration varies per widget.
Allows to filter the set of objects that the filter includes in its
representation.
Allows to create an image of the current displayed widget. The
image can be used to include in your report.

Widgets are available at different levels. In the next sections all widgets will de discussed, including their
configuration and available location(s).

8.4.1

Risk matrix
The risk matrix is available at the project level only. It visualises the risks in respect to their chance
and severity.
Risk matrices can be shown on project reports tabs as well as on the project's risk log.
This matrix sets the risk numbers in the cells according to their values for impact (severity) and
probability (chance).
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A risk matrix

Configuring the risk matrix:
The risk matrix automatically configures itself based on the risks in the risk log.

8.4.2

Burn-down chart
The burn-down chart is available at the project level only. It visualises planned versus actual hours
within a configurable period.
Burn-down charts provide a burn-rate (burn-up or burn-down) as planned and actual to monitor project
progress.

Burn-down chart

Configuring the burn-down chart:

1. Click

, a pop-up appears.
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Configuration of the burn-down chart.

2. Enter the name of the chart and choose the chart type; either burn-down or burn-up.
3. Set the series to be shown; Ideal Trendline, Current Trendline, Planned (bar chart) and/or Actual
(bar chart).
4. Set the start date to either the project start date or a fixed date.
5. Set the end date to either the project end date or a fixed date.
6. Click 'OK' to save the configuration.

8.4.3

PRINCE2 process diagram
PRINCE2 process diagrams are available at the Generic projects only.
It visualises the PRINCE2 project process with respect to the project plan and progress.

PRINCE2 process diagram

Configuring the PRINCE2 process diagram:
This widget configures itself automatically, highlighting the current stage of the project.

8.4.4

Timeline chart
Timeline charts are available at projects, programmes, folders and portfolios.
They visualise timeline information on costs and/or hours for selected types (budget, actual, etc.).
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Timeline chart

Configuring Timeline charts:

1. Click

, a pop-up appears.
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Configuration of the timeline chart.

2. Enter the name of the chart and choose the chart type; either Bar, Bar Cumulative, Line or Line
Cumulative.
3. Set Costs, Resources and Legend to be shown (if desired).
4. Set the start date to either a dynamic range of a fixed date.
5. Set the scale to either Weeks, Months, Quarters or Years.
6. Set the horizon.
7. Select the types to be selected.
8. Click 'OK' to save the configuration.

8.4.5

Gauge meter
The gauge meter is available at programmes, folders and portfolios.
It visualises a single value against a conditional meter indication (green, amber, red).
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Configuring the gauge meter:

1. Click

, a pop-up appears.

Configuration of the gauge meter.

2. Enter the name of the chart.
3. Select whether the meter is set for a field on the programme (cost, hours, etc.) or a sum of the
field on project (projects overdue, total costs, etc.)
4. Set the Thresholds for the meter.
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5. Set the Range for the gauge meter.
6. Click 'OK' to save the configuration.

8.4.6

Scatter plot
The scatter plot is available at programmes, folders and portfolios.
It visualises projects weighted to different axes. An indication of good/bad can be shown using
different colour gradients.

Scatter plot

Configuring the scatter plot:

1. Click

, a pop-up appears.
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Configuration of the scatter plot

2. Enter the name of the chart.
3. Optionally; set a filter for a field
4. Choose whether or not bubbles with the same value should be slightly moved so all of them are
visible.
Note: When the scatter plot does not show the appropriate values this could be due to internal
values of the Principal Toolbox.
5. Choose a field for the X-axis and set the range (either dynamic or fixed), also set a highlight value.
6. Choose a field for the Y-axis and set the range (either dynamic or fixed), also set a highlight value.
7. Optionally: set the background gradient to indicate good/bad scores.
8. Click 'OK' to save the configuration.
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Bubble chart
The bubble chart is available at programmes, folders and portfolios.
It visualises projects weighted to different axes. Additionally, the size can be used for indication of
impact.

Bubble chart

Configuring the bubble chart:

1. Click

, a pop-up appears.
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Configuration of the bubble chart

2. Enter the name of the chart.
3. Optionally; set a filter for a field
4. Choose whether or not bubbles with the same value should be slightly moved so all of them are
visible.
5. Choose whether the legend should be visible.
Note: When the scatter plot does not show the appropriate values this could be due to internal
values of the Principal Toolbox.
6. Choose a field for the X-axis and set the range (either dynamic or fixed), also set a highlight value.
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7. Choose a field for the Y-axis and set the range (either dynamic or fixed), also set a highlight value.
8. Optionally: set the bubble properties:
Size: Select the field that determines the size of the bubble.
Colour: Base the colour on a field or set the colour to random.
9. Click 'OK' to save the configuration.

8.4.8

Bar chart
The bar chart is available at programmes, folders and portfolios.
It visualises project values grouped by different options in bar layout.

Bar chart

Configuring bar charts:

1. Click

, a pop-up appears.

Principal Toolbox 8.0

Reporting

200

Configuration of the bar chart

2. Enter the name of the chart.
3. Optionally; set a filter for a field
4. Choose whether or not bubbles with the same value should be slightly moved so all of them
are visible.
5. Choose whether the legend should be visible.
Note: When the scatter plot does not show the appropriate values this could be due to
internal values of the Principal Toolbox.
6. Choose a field for the X-axis and set the range (either dynamic or fixed), also set a highlight
value.
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7. Choose a field for the Y-axis and set the range (either dynamic or fixed), also set a highlight
value.
8. Optionally: set the bubble properties:
Size: Select the field that determines the size of the bubble.
Colour: Base the colour on a field or set the colour to random.
9. Click 'OK' to save the configuration.

8.4.9

Pie chart
The pie chart is available at programmes, folders and portfolios.
It visualises project values grouped by different options in pie layout.

Pie chart

Configuring pie charts:

1. Click

, a pop-up appears.
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Configuration of the pie chart

2. Enter the name of the chart.
3. Set the values; either count project or the sum of a field (Cost Budget, Benefit, etc.).
4. Set the field by which the pie chart should be grouped (Current stage, Benefit status, etc.).
5. Choose whether/when slices should be combined.
6. Select what should be shown in the pie chart (Label, Percentage, Values, Total and Legend).
7. Click 'OK' to save the configuration.

8.4.10 Resource utilisation
The resource utilisation widget is available within Resource Management (within an organisational
unit).
It visualises information of a resource (availability vs. allocated) and whether the request and
allocations are leveled etc.
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Configuring the resource utilisation widget:

1. Click

, a pop-up appears.
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Configuration of the resource utilisation widget

2. Enter the name of the chart.
3. Set the start date; either dynamic or fixed.
4. Set the scale either to Weeks or Months.
5. Set the horizon either to 1, 3, 6 or 12 Months.
6. Set the unit to be used (Hours, Man days or Man weeks).
7. Choose for which fields data should be shown; Actual, Allocation, Available, Planned and/or
Request.
8. Choose how the non-project related entries will be represented.
9. Choose the comparison.
10.Click 'OK' to save the configuration.
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8.4.11 Hour Report
The hour report is available at the home page and within time registration groups.
It visualises information of a resource (availability vs. allocated) and whether the request and
allocations are leveled etc.

Hour report widget

Note: The hour report widget only reports on approved time sheets.
Configuring the personal hours widget:

1. Click

, a pop-up appears.

Configuration of the hour report.
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2. Select the start date.
3. Set the horizon to 1, 3, 6 or 12 months.
4. Choose whether only project rows will be shown.
5. Select the type; Available, Request, Allocation, Planned and/or Actual.
6. Set the scale default value; Days, Weeks or Months.
7. Click 'OK' to save the configuration.

8.4.12 Treemap
The Treemap widget is available at programmes, folders and portfolios.
It visualises project values grouped by different options in nested rectangles.

Treemap widget

Configuring the Treemap widget:

1. Click

, a pop-up appears.
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Configuration of the Treemap widget

2. Set the name of the Treemap.
3. Select the field to distribute the Treemap by (Benefit, Costs, ID, etc.).
4. Select the field to group the Treemap by (Benefit status, Effort requirement, etc.).
5. Select the colours of the Treemap. Either fixed, random or based on a field.
6. When the colour is set to be based on a field, select this field (Status, Technology risk rate,
etc.).
7. Optionally: Set a filter for a field.
8. Choose what should be shown in the Treemap (Label, Values, Total, etc.).
9. Click 'OK' to save the configuration

8.4.13 Project map (Geo)
The Project map (Geo) widget is available at programmes and folders only.
It visualises projects on their GPS location. When they don;t have a GPS-location yet, they can also
be dragged to one.
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Project Map widget

Configuring the Project map (Geo) widget:

1. Click

, a pop-up appears.

Configuration of the project map

2. Set the name of the Project map.
3. Select project location field (portfolio name, project number, etc.).
4. Select the marker colour (single colour of based on a field).
5. If the colour is set to be based on a field, select the field (status, benefit status, etc.).
6. Select the view. Either use a saved default view or zoom to show all projects.
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7. Optionally: Set a filter for the fields.
8. Click 'OK' to save the configuration

8.4.14 Bullet chart
Bullet charts are available at programmes and folders only.
A bullet chart “provides a rich display of data in a small space.” A variation on a bar chart, bullet
charts compare a given quantitative measure against qualitative ranges and related markers.

Bullet chart widget

Configuring the bullet chart:

1. Click

, a pop-up appears.

Configuration of the bullet chart

2. Set the name of the bullet chart.
3. Select the actuals to be used (Cost, Cost Budget, etc.).
4. Select the Target to be used (Cost, Cost Budget, etc.).
5. Select the Forecast to be used (Cost, Cost Budget, etc.).
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6. Set the thresholds for the bullet chart and choose whether the tolerances should be coloured
or not.
7. Click 'OK' to save the configuration

8.4.15 Image and Text
Image and Text widgets are available at programmes, folders, portfolios and projects.
The Image and Text widget shows texts, images and hyperlinks to documents and websites.

Image and Text widget

Configuring the Image and Text widget:

1. Click

, a pop-up appears in which you can enter the title of the widget.

2. Click
to enable a rich text editor in which you can add images and hyperlinks or type a
piece of text.
3. Click 'Save' to save the Image and Text widget.

8.4.16 Prince2 Organisation
The PRINCE2 Organisation widget is available at the project level only.
It visualises the PRINCE2 project organisation with all roles of the project.
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Configuring the PRINCE2 Organisation widget
The PRINCE2 Organisation widget is automatically configured based on the roles of the project
members.

8.4.17 Earned Value Management (EVM)
Earned Value Management (EVM) is available at the project level only.
It visualises the planned value, earned value and actual cost of a project (in both, a graph and a
table).
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Configuring Earned Value Management (EVM):

1. Click

, a pop-up appears.

Configuration of Earned Value Management (EVM)

2. Set the name of the widget.
3. Select the EVM Method (Approval Status, Category, etc.).
4. Select the scale (Weeks, Months, Quarters, Years).
5. Select the Input Type, either Entry or Field.
6. When the input is set to Entry; select the Resource Type (Costs or Hours).
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7. When the input is set to Field; select a field to be used as Planned Value (ID, Outline Level,
etc.).
8. When the input is set to Field; select a field to be used as Actual Cost (ID, Outline Level,
etc.).
9. When the input is set to Field; select the Category (Approval Status, Priority, etc.).
10.Click 'OK' to save the configuration
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System Administrator: Configuration & Settings
The administrator can simply control the Principal Toolbox via the 'Configuration' and the 'Settings'. In
order to access the 'Configuration' you need to click Setup in the dark blue header of the Principal
Toolbox application and select Configuration. To access the 'Settings' you need to click Setup in the
dark blue header of the Principal Toolbox and select Settings. These functions are initially only available
to users with administrator rights.

Configuration page

Settings page

On the Configuration page you can find several functional configuration options, such as non-project
activities and custom fields.
On the Settings page you can set technical settings related to the system such as mail server etc.
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Configuration
On the Configuration page you can find several configuration options, such as non-project activities and
custom fields. On the left hand side of the page you see a list with subjects that point to the different
setup pages.
We will review the most important subjects in this section:
- Principal Toolbox settings 216
- Email notification 216
- Creating non-product activity sets 217
- Defining custom fields 220
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Principal Toolbox
Note: this section is only relevant to system administrators.
This is an overview of the system settings. Normally spoken these do not need to be changed. Some of
these settings will only be shown when add-on's are activated.
Page

Link

Setting

Standard value

Remarks

Only expand activ e and
next stage

No

Activ ate product selector
in logs

Y es

Use of PRINCE2™ roles

No

If the f ull PRINCE2 organisation is used within the
organisation, select 'Yes'.

As soon as possible
constraint

As soon as possible

If progress of project is to be monitored in MS Project
change this to 'Yes'

Must f inish on constraint

Must f inish on

To change to a NL v ersion of MS Project:
“ Moet eindigen op ”

Must start on constraint

Must start on

To change to a NL v ersion of MS Project
“ Moet starten op ”

Principal Toolbox

MS Project f ile
export

Time entry (add-on)
Manage time
sheets

Click 'New' to create new time sheets or select a
specif ic time sheet and click 'Remove' to delete.

Cost entry (add-on)
Manage cost
entries

Select a Cost entry and click 'Remove' to delete cost
entries which are not approv ed.

Advanced System Settings
Here only advanced system settings that are set to non-default values are shown. When a system
setting is added with the default value, it will be automatically removed.
Before adding or changing anything contact our Customer Service desk (Tel: +31 88 - 888 42 22 or mail
to support@fortes.nl)

9.1.2

Email notification
Email notification on log items, time sheets, approvals etc. sends an email automatically when
something becomes overdue.
Most of the notification are turned off by default.
Modify e-mail notification settings
1. Go to Setup > Configuration > Notifications
1. Click on Edit to modify the notification settings
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Email notification settings

9.1.3

Creating non-project activities
Specify non-project activity sets for activities that are done outside projects. This can be productive
hours, like service management, meetings, general, etc. You can also add a category for non-productive
hours, like sickness, holidays, special leave etc.
Different sets can be defined if different departments use different categories or have different non-project
activities. It is also possible to have multiple non-project activity sets active for one group. So you could
define one set for the entire organisation (e.g. with the categories sickness, leave), and a separate set for
each department with department specific activities.
Creating non-project activity sets
1. In the dark blue bar in the top, click 'Setup' and navigate to 'Configuration'.
2. On the left side of the screen you will find 'Configuration', click 'Manage Non-project Activity Sets'.
3. Click on New in the section 'Non-project activity sets' to create a Non-project Activity Set.

Non-project activity sets on the 'Setup' page

3. Then fill in the following information:
Name
Objective

:
:

Name of the non-project activity set.
Objective of the non-project activity set.
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4. Click OK to create the non-project activity set.
5. When the non-project activity set is stored, it will appear in the listing of 'Non-project activity sets'.
Now click the created set to add the non-project activities to the set.

6. Click
up.

to add categories and activities, or to change the current set-

7. In the window that has been opened, you can create new items with drag and drop.
a. First add a new category. Drag New category into the lower part of the window as shown below.

b. In the pop-up, add a name for the category.
c. Then, drag new activity into the category, as shown below.
d. Give a name to the new activity.
Note: Activities can only be placed inside categories, so you'll need to define at least one
category.
e. Add new categories and activities to get your set complete. Below you find an example of
categories with activities.
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Defining custom fields
Within organisations there often is a need to define custom fields such as, for example; project costs,
SAP numbers and project codes or there is the need to have extra fields on, for example the logs, the
product page or a folder level. With the Principal Toolbox you are able to define these fields.
These fields can be used for defining custom views and reports.
1. Go to the Configuration page by clicking on Setup and Configuration.
2. Click the link Customize fields. Then you select the item where you want to add a custom field. You
can define custom fields on all available objects in the Principal Toolbox.
3. Click the specific item to define a custom field. Click

+ to define a custom field.

Defining a custom field

4. An new window will open where you need to fill in the following data:
Available for use
Field name
Field description
Editable
Field type
Field width
Field default value

:
:
:
:
:
:
:

Highlight to make the field available on the pages.
Name of the custom field.
Description of the field.
Highlight to make the field editable.
Select the type of the custom field.
Width of the field on the screen.
Default value of the field.

5. There are some different field types available for the custom field. We will explain them shortly:
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String
Memo
Number
Double
Currency
Date
Checkbox
Pick list (single)
Pick list(multi)
Person (single)
Person (multi)
Image (single)*

:
:
:
:
:
:
:
:
:
:
:
:
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Text field with max. 255 characters.
Text field with unlimited characters.
Number field with no decimal accuracy (for example 2342).
Number with single decimal accuracy (for example 3,5).
Number with two decimal accuracy (for example 3,45).
Date field
A basic checkbox.
From the pick list only one can be selected.
From the pick list multiple values can be selected.
From the pick list only one person can be selected
From the pick list multiple persons can be selected
From the pick list only one can be selected. The value is shown by an
image rather than text.

When selecting a pick list, a new data field will appear named ‘Pick lists values’ where you can
specify the different values.
6. Then click OK and the field will be available at the specific page.

Default the Principal Toolbox is configured with ten custom fields for each item. If you
need extra custom fields these can be created with the Add custom fields button

Remember: To reset an existing custom field go to the edit page of the custom field -> Click Edit'->
Click Advanced and then hit the Reset button. When you are sure you want to reset the field click OK.
All values inserted by users will be deleted from the system and can not be retrieved !
* Image f ields are av ailable as of release 6.1

9.2

Settings
In the middle of the 'Settings page' you can see the information of your current license. Underneath are
options to alter the license key and the version type. On the left hand side of the page you see a list with
subjects that point to the different settings pages.
We will review the most important subjects in this section:
obtaining the license key and carrying out updates 221
management of users 223

9.2.1

Licenses
Under the heading License key on the Settings page you come across a number of options:
- Request license key 221 ;
- Request additional user licenses
- Renew expired license key 222 ;
- Enter license key 222 ;

9.2.1.1

222

;

Applying for a license key
If you have carried out the installation yourself and then arrived at the 'Settings' page it is necessary to
request for a license key at Fortes Solutions.
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1. Go to the 'Settings' page.
2. Click the link Request license key.
3. Fill in the following information:
Customer Name
Purchase order
Machine ID

:
:
:

Company name
Code received in letter sent.
Filled in automatically.

4. By clicking the key Create e-mail a message or mail is made which you will need to send. Within
one work day you will receive a license key from Fortes Solutions.

9.2.1.2

Request for additional user licenses
The license you received is based on the number of users named in the Principal Toolbox. If you have
reached the maximum number of user licenses you cannot make any new users. With the option
‘Request additional user licenses’ you are able to increase the number of existing licenses.
1. Go to the 'Settings' page.
2. Click the link Request additional user licenses.
3. Fill in the following information :
Purchase order

:

New User Limit

:

Code received in the post or if your first request for more licenses you
can fill in unknown or ‘-’.
Here you can fill in the number of users that you really need.

4. By clicking the key Create e-mail a mail is then made which you are required to send. As soon as
the extra licenses are approved you will receive a new license key from Fortes Solutions.

9.2.1.3

Renewal of an outdated license key
If your license has expired you can request a new license using this option.
1. Go to the 'Settings' page.
2. Click the link Renew expired license key.
3. Fill in the following information:
Purchase order

Code received in the post or if your first request for more licenses you
can fill in unknown or ‘-’.
.
4. By clicking the Create e-mail key a mail will be made that you will need to send. Within one working
day you will receive a new license key from Fortes Solutions.

9.2.1.4

:

Setting up the license key
After making a request for a license key in one of the ways shown above you will receive the necessary
information by e-mail. This license key then needs to be activated in the Principal Toolbox.
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1. Go to the 'Settings' page.
2. Click the link Enter License key.
3. Fill in the following information:
Name
Key

:
:

Name of the organisation; Fill in the exact name as written in the e-mail.
The license key from the e-mail.

4. Then click OK whereupon the license key will be activated. You will be required to restart system in
which the Principal Toolbox runs, once again.
In some cases the Principal Toolbox will give an alert on the license page (main page of the Settings),
ignore this alert and start up the system once more. If the alert continues then check again whether all
information is filled in correctly.

9.2.2

User administration
Control of users of the Principal Toolbox runs via de Settings page. Using the link User Administration
you are able to control the existing users and to add new users.
1. Hover over 'Settings'.
2. Click the link User Administration. A list of all users of the Principal Toolbox will appear.
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+ in order to add a new user.

4. The screen Add person appears, fill in the
following data:

Initials
Last name
Email
Hour rate

:
:
:
:

Username
External (add-on)

:
:

System Role

:

Remarks

:

Initials of the user.
Surname of the user.
Users email.
Hour rate (optional). This hour rate is used in the add-on hours
registration.
User name
Highlight if the user is an external supplier in the project. By doing this
only the allocated products, issues, etc. are visible.
Normal User or Administrator. The administrator role has logically all
rights. A normal user, has only the rights that are allowed depending on
his/her permissions within the folders and projects.
User specific remarks to send within the e-mail.

5. Click OK in order to make a user in the system.
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An email will be generated based on
this information. When there is no mail
server configured in the Principal
Toolbox or there is no email address
filled in during the creation of the new
account, you are able to fill the email
with the relevant information and then
send this further to the user by
yourself. Otherwise the Principal
Toolbox will generate the email
automatically and send this to the
users email address.
In order to delete users or to change
the current information you go to the
User Administration page and by
using the Edit and Remove buttons
you are able to alter or remove
information about a user.

As of release 6.5, the Principal Toolbox allows for user groups
9.2.2.1

226

as well.

Personal details
Besides the basic information for the user login there is an option to add detailed information per user/
resource.
1.

Go to the 'Settings' page.

2.

Click the link User Administration. A list of all users of the Principal Toolbox will appear.

3.

Click a specific user/resource to add the detailed information.

4.

Now click Edit to insert the following information:
Company
Address
ZiP/Postal Code
City
Country
Phone
Phone (home)
Fax
Mobile
Birthdate
Gender
Remarks
Calendar

:
:
:
:
:
:
:
:
:
:
:
:
:

Name of the company.
Address of the company.
ZIP/Postal Code.
City where the office is located.
Country where the office is located.
Office phone number.
Private home phone number.
Fax number.
Mobile phone number.
Date of birth.
Male or female.
Any remarks.
Calendars applicable to the user
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Person details

9.2.2.2

User Groups
User groups can be created to make user administration within the Principal Toolbox easier. As an
example, consider a department where all department users need permission to view projects within a
work area (folder). By defining a user group and adding the appropriate members, only the user group
needs to be added to the work area to allow all members within the user group to view the projects within
this work area.
To add and/or modify user groups, navigate to the user administration

Create user group

Once a group is created, users can be added to the group.

223

and click the 'Groups' tab.
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Add and remove users to a group

Once users have been assigned, user groups can be set to the membership at various locations in the
application, for example the members of a folder or portfolio. Groups are shown in blue and have the text
'(User group)' added to their name.

Edit members with groups

Note: In release 6.5 it is not yet possible to assign a user group to a time entry group.
once a user group is set, users of the group inherit the permissions that the user group itself is set to.
For example, users now have reading permission on the folder that are set to in the example above.

Principal Toolbox 8.0

9.2.2.3

System Adm inistrator: Configuration & Settings

228

Advanced options
The administrator has rights to modify advanced options for the login policy. There are several security
settings possible for the password.
Go to the Settings page and navigate to System settings > User login settings

User login settings

These settings can be changed:
Password expiry time in days

:

Maximum incorrect attempts

:

Lockout duration

:

Minimal password length
Mix upper en lower case letters
Use special symbols in passwords

:
:
:

User numbers in passwords

:

This is the time (in days) a password is valid. After this
date the user has to enter a new password. ('0' is no
expiry)
Number of login attempts before a user account is locked.
('0' is infinite)
Number of minutes a user account stays locked. ('0' is
infinite, the administrator can reset a locked account.)
The number of characters a password should consist of.
Enforce the user of both upper and lower case letters.
Enforce the use of symbols (non alphanumeric) in each
password, like @, &
Enforce the use of numbers in a password.

The administrator is able to reset an account. When an account is reset a new password is created by
the system.
Go the User Administration and open the account to reset.

Password reset
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System Settings
Note: this section is only relevant to system administrators.
This is an overview of the advanced system settings. Normally spoken these do not need to be changed.
Some of these settings will only be shown when add-on's are activated.
Page

Link

Setting

Standard value

Remarks

Document storage
location

Location chosen
during installation

All documents within the Principal Toolbox are sav ed
and coded here

Def ault sy stem locale

English

Def ault language settings f or the all users. Users can a
personal language if setting 'Personal locale' is set to
yes.

First week of the y ear

Week that contains
a minimum of 4
day s in January
(ISO)

Conf igure week numbering.

Personal locale

No

Users can a personal language if setting 'Personal
locale' is set to yes.

Link to Document
Management Sy stem

-empty -

Specif y a URL to a external location which is used to
add a external document link.

Application location

-def ault v alue-

Only change when problems.

Garbage collector

Y es

By normal use, keep the standard v alues.

Debug

No

By normal use, keep the standard v alues.

Max f ile size

90 Mb

By normal use, keep the standard v alues.

Person display name

Last name, initials

Modif y if necessary

URL pref ix static f iles

-def ault v alue-

Number of currency
decimals

2

Number of display ed decimals f or all currency v alues.

Login ty pe

Basic

Change if one works with IIS.

Multiple domains

No

Sy stem settings

User Login
settings

More settings:
See User administration >
Adv anced options 228

Mail

LDAP settings

SMTP Serv er

Specif y the SMTP serv er f or sending email

Sy stem address

f rom-address used f or emails automatically sent by
Principal Toolbox, f or example notif ications.

Fixed f rom-address

Fill in a f ixed f rom address which is used instead of the
users email address when sending email f rom Principal
Toolbox

Fixed reply -to address

only specif y when all mails sent should be replied to
one email address

all settings and f ield mappings f or LDAP
sy nchronisation.
Contact support@f ortes.nl f or more inf ormation about
LDAP sy nchronisation and Single-sign-on options
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Remarks

Updating the software
Implementing updates and the installing of new releases of the Principal Toolbox is done via the
‘Settings’ screen. You will receive a file in the form of a .jar or .sql file from Fortes Solutions in order to
implement an update or to be able to install a new release.
Remember: Before starting the update we recommend to back up the database and application. Users
should be informed of the update and should not be work ing on the system during the update.
1. Go to the 'Settings' page.
2. Click the link Update software.
3. Now click Start update procedure.
4. Log out all active users and click Proceed with step 2.
5. Wait while storing the unsaved data and select the checkbox in front of Check when backup of
database has been performed.
6. Click the button Proceed with step 3.
7. Locate the appropriate file (.jar file or .sql file) using the Browse key.
8. Click the Proceed with step 4 key in order to carry out the update.
9. After completion of the update, the update procedure restarts the Principal Toolbox application.
10.After the restart, log in as administrator and wait for update processes and the sanity check to finish.
This can take time depending on the update and the size of the database.
11.The system is ready for use after completion of the update processes and the sanity check.
When problems or fault announcements arise please contact Fortes Solutions: support@fortes.nl.

9.2.5

Classic Project Migration
As of release 6.5, classic PRINCE2 projects 118 can be migrated to generic PRINCE2 projects 78 . By
default, this option is not activated as it requires configuration by your administrator before migrations
can be performed.
The generic project planning provides flexible planning support and improved usability that allows for
activity planning, multiple breakdowns, integrated cost/hour planning etc. However, some functionality is
deprecated in the new planning that is available in the classic planning:
· The classic plan tab is no longer available, this is now integrated in the planning
· Unused work packages are no longer maintained separately
· Microsoft Project export/add-in is no longer available
· Classic cost/hour administration is replaced entirely
Note: Once migrated, projects cannot be migrated back . Therefore, this option should be used
with great care as certain information might be lost (see below) and functionality changes
significantly within the project.
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Note: If possible, it is advised to finish the project rather than migrate the project to the generic
PRINCE2 planning.
Note: Verify custom calculations on products and projects to be compatible with the new planning
before migrating projects.
The general approach to enable project migration is as follows:
1. Configure project migration at Setup > Configuration > Classic Project Migration
2. After activation, migrate the original classic project model(s)
3. After migrating the original model, migrate classic projects based on this (these) model(s)
1. Configure project migration
At Setup > Configuration > Classic Project Migration the project migration can be configured and
activated (after configuration).

Migration of classic project planning

Initially, the migration option is disabled and cannot be activated unless some decisions are taken for the
following information:
· classic draft and check milestones
· classic reviewer role
· pre-select option for time sheets
For each of these it must be decided whether the information is no longer used or copied to custom
fields. These custom fields need to be created before selecting at this configuration. Once this has been
configured, the migration can be activated, see below.
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Activating migration

The migration option needs to be set to 'Yes' to activate the migration at project models (and projects).
Also, it can be set whether administrators and/or project managers can perform the migration. By default
this is set to administrators only.
2. Migration at the project model
Once activated, the migration option is shown on project models.
Note: Migration is not available at projects itself until the project model that the projects are based
on has been migrated!
The header of the project model now shows a 'Migrate' button in amber. For users allowed to perform the
migration, a click will bring up the dialog shown below. If the user clicks 'Migrate', the project model is
migrated.

Migrate project model to generic project planning

After migrating the project model, the same option appears at the related projects as well. The outcome
of the migration would then look like this:
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Troubleshooting and Solutions

10.1

Troubleshooting
Sort

233

Issue

Solution

Internet Explorer window stay s blanc or Principal Toolbox logo
hangs af ter login.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Miscellaneous
section, set Allow META REFRESH to enabled.

Single Sign On is enabled, but Internet Explorer ask user
credentials when opening the Principal Toolbox.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the User
Authentication section, check the setting Logon and adjust to
the signif icant v alue.

Can't login into the application because the login button doesn't
work at all.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Scripting
section, set Active scripting to enabled.

Login

Automated reports and document downloading and uploading
Automated reports and documents can't be downloaded.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Downloads
section, set File download to enabled.

Key words f or automatic reports won't be copied to the clipboard.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Scripting
section, set Allow Programmatic clipboard access to
enabled.

There are noPrincipal Toolbox reporting toolbars in the Excel
template av ailable.

Make sure y ou hav e sav ed the f ile bef ore opening. On the
Tools menu, click Macro > Security. When the Security dialog
is opened, click the tab Security Level and set the security
lev el to Medium. Re-open the Excel template. Excel should ask
to accept to run macros.

Nothing happens when the Sav e list as RTF button is clicked

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Downloads
section, set File download to enabled.

Edit Project Plan
Drag and drop in Edit Project Plan window won't work.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Scripting
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Solution
section, set Active scripting to enabled.

Internet Explorer blocks a pop-up af ter adding the f irst product
on the Edit project plan page.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Miscellaneous
section, set Use Pop-up Blocker to disabled (make sure there
are no other Pop-up blockers activ e).

The Edit Project Plan window hangs while message "Processing
please wait" is display ed.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the ActiveX controls
and plug-ins section, set Script ActiveX controls marked
safe for scripting to enabled (make sure there is no other
script blocking sof tware activ e).

Gantt chart editing
Can't drag bars in edit Gantt dialog.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Scripting
section, set Active scripting to enabled.

Miscellaneous
Internet Explorer reports Script errors on dif f erent pages.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the ActiveX controls
and plug-ins section, set Initialize and script ActiveX
controls not marked as safe for scripting enabled

Links to projects and f olders on the homepage doesn't work.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Scripting
section, set Active scripting to enabled.

Pack Project Of f line window hangs while message "Processing
please wait" is display ed.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Downloads
section, set Automatic prompting for file downloads to
enabled.

No pop-up windows are opening while clicking links.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Miscellaneous
section, set Use Pop-up Blocker to disabled (make sure there
are no other Pop-up blockers activ e).

Can't download the MS Project Client add-in.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Miscellaneous
section, set Launching applications and unsafe files to
enabled.

Functions in drop down menus won't work.

On the Tools menu, click Internet Options. Open the Security
tab and click the Custom level button. In the Scripting
section, set Active scripting to enabled.
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